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Important Notice 
 
 
Please take notice of the following remarks when installing the RAMCO Demo. 
 
1.  RAMCO has originally (Octobre, 1996) been developed (Contract RKZ-308) for the 

National Institute for Coastal and Marine Management (RIKZ) and the associated 
Coastal Zone Management Centre (CZMc), P.O. Box 20907, 2500 EX The Hague, 
The Netherlands.  RAMCO has been developed by INFRAM bv, P.O. Box 81, 3890 
AB Zeewolde, and RIKS bv, P.O. Box 463, 6200AL Maastricht, The Netherlands. 

 
2.  The version 2.0 of RAMCO is the result of the Land Water Environment 

Information technology (LWI) - Project “Integral Systems Analysis”, in the “LWI - 
Estuaria and Coasts” project group. The end-users of this LWI-product are: National 
Institute for Coastal and Marine Management (RIKZ) and the Coastal Zone 
Management Centre (CZMc), and the Netherlands Organization for the 
Advancement of Tropical Research (WOTRO). The developers group consists of: 
INFRAM bv, RIKS bv, and WL|Delft Hydraulics. 

 
3.  The SW Sulawesi model makes extensive use of knowledge gathered in project 

W01.60 of the Netherlands Organization for the Advancement of Tropical Research 
(WOTRO).  This scientific material remains the full property of WOTRO. 

 
4.  If you have on your machine other RIKS applications, such as: GEONAMICA®, the 

LEEFOMGEVINGSVERKENNER, WADBOS, the ISLAND Demo, SIMLUCIA, the 
CELLCITY Demo or earlier versions of the RAMCO Demo, then put the RAMCO 
version 2.0 files in a dedicated directory different from the one(s) that contain(s) any 
of the other applications.  Do not interchange files between the different applications 
as files may have the same name but different contents. 

 
5.  RIKS bv is constantly trying to improve its applications.  It is our policy to provide 

you with the most recent versions of the programs and manuals available.  However, 
as a result, you may receive an application that is slightly different from the one 
described in the manual.  Do not hesitate to contact us if this would cause you any 
problems. 

 
6.  The RIKS Demos are curtailed versions of more elaborate software products.  Each of 

the Demos is conceived to allow you to get a good understanding of the full software 
product.  If you are interested in a demonstration of the full version, you are welcome 
to contact RIKS bv. 

 
7.  Neither software development with the tools provided in the RAMCO package nor the 

application of the RAMCO package to a case study is permitted. 
 Software or application development and further usage or marketing of the RAMCO 

package will only be accepted following the purchase of a full version of the package. 
 
Enjoy our demos and please return your comments to us. 

 
RIKS bv, P.O. Box 463, 6200 AL Maastricht, The Netherlands 
Tel. 31-43-388.33.32; Fax. 31-43-325.31.55; e-mail:info@riks.nl; http://www.riks.nl/ 
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1. Introduction 

RAMCO is a prototype of an information system which is to evolve eventually into a 
Generic Decision Support Environment for the Integral (or rapid) Assessment of Coastal 
Zone Management problems.  The ultimate aim is to develop an environment that will be 
applicable for the purpose of (1) integral assessment of (2) a wide range of coastal zone 
management problems, in (3) a large variety of coastal zones.  The term generic in this 
report is to be understood is this sense. 
 
The first version of RAMCO was developed as part of the project: “RAMCO: Generic 
Decision Support System for the Rapid Assessment phase of Sustainable Coastal Zone 
Management” financed by the National Institute for Coastal and Marine Management 
(RIKZ), Rijkswaterstaat, and the associated Coastal Zone Management Centre (CZMc), 
Contract RKZ-308 and carried out by the consortium consisting of INFRAM bv 
(Zeewolde, main contractor), and RIKS bv (Maastricht). 
 
The version 2.0 of RAMCO is the result of the Land Water Environment Information 
technology (LWI) - Project “Integral Systems Analysis”, in the “LWI - Estuaria and 
Coasts” project group.  The end-users of this LWI-product are: National Institute for 
Coastal and Marine Management (RIKZ) and the associated Coastal Zone Management 
Centre (CZMc), and the Netherlands Organization for the Advancement of Tropical 
Research (WOTRO).  The developers group consists of: INFRAM bv, RIKS bv, and 
WL|Delft Hydraulics (Delft).  The Technical University of Twente, Department of Civil 
Engineering Technology & Management, (Enschede) participated as a sub-contractor of 
INFRAM bv. 
 
Both version 1 and version 2 of RAMCO are applied to the Coastal zone of SW Sulawesi 
(Indonesia).  The model of the coastal zone of SW Sulawesi makes extensive use of 
knowledge gathered in project W01.60 of the Netherlands Organization for the 
Advancement of Tropical Research (WOTRO).  This scientific material remains the full 
property of WOTRO and the scientific teams that carried out the original research. 
 
This demo is an implementation for demonstration purposes of RAMCO and runs on PC 
compatible machines.  The scientific philosophy which is at the base of RAMCO and the 
RAMCO methodology is described at greater length in a number of publications and 
technical reports mentioned in the reference list of this user guide.  The demo will be 
best used in combination with a selection of these documents. 

1.1. Decision Support Systems. 

Decision Support Systems are defined here as computer-based information systems that 
are built to assist decision makers address semi-structured problems by allowing them to 
‘access’ and use ‘data’ and ‘analytic models’ (Najdawi and Stylianou, 1993). 
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‘Access’ to models and data is provided by means of the user interface (UI), which is --in 
the state of the art systems at least-- of a graphical nature (GUI) and is to hide the 
technical (software) complications of the information system from the end-user. 
 
The ‘data’ required to correctly and formally define, analyse and possibly solve the 
decision problem, are stored in the database management system (DBMS) of the DSS.  
For decision making problems with an explicit geographical nature, such as Coastal Zone 
Management, a more versatile solution is to have a GIS take care of data management.  
GIS have additional analytical and decision support features that potentially can enhance 
the capabilities of the DSS. 
 
Finally, the ‘analytic models’ are stored in the model base management system (MBMS) 
of the DSS.  Typically ‘decision models’; statistical and operations research methods, as 
well as tools to portray, compare and evaluate different decision alternatives, are part of 
it.  Even more essential in the model base are the ‘domain specific models’ capable of 
grasping the complexities of the system and the problems under study.  All the 
instruments in the model base are of a formal nature hence exclude decision making 
based on common sense, hear say or intuition solely.  Good formal decision support 
methods will rather assume that the decision maker desires to make decisions on the 
basis of a consistent line of reasoning and will suggest solutions in a way that makes 
intuitive sense to him. (Holtzman, 1989) 
 
We insist on the fact that a DSS is not the same as ‘a model with a nice user interface’. 
This abuse of the term DSS has become very common.  The difference between a 
‘model’ and a ‘DSS’ resides in the fact that a model solves a very precisely defined 
problem, while the DSS is developed to solve problems that can not easily be reduced to 
known problems or solutions.  It provides the user with models, methods and tools that 
allow to find the best possible answer to the problem.  Hence, it will not necessarily give 
a precise answer or solution, rather it will approach a solution in a manner similar to an 
heuristic procedure. 
 
DSS emphasise flexibility, effectiveness and adaptability, hence are at best systems with 
an open architecture to permit their renewal and expansion as new knowledge and tools 
become available.  The primary function of DS systems is to improve the quality of the 
decision making process.  It is inherently understood that if the process can be improved, 
higher quality decisions will be the end result.  From the management sciences, DSS 
methodologies have adopted the view that ‘decision making’ is a process consisting of 
various stages that are stepped through linearly or cyclically.  Generally three major 
phases are defined in the decision making process (Janssen, 1992): the identification 
phase, the development phase and the selection phase. 

From the fields of psychology and economics, the idea is adopted that decision making is 
a normative process: given a certain definition of optimality, decision rules are developed 
that result in an optimal solution for a stated problem.  Coastal Zone Management 
problems are rarely posed in terms of a single goal, rather as sets of different, 
simultaneous, often contradicting goals that should be met when and where possible.  
This involves ‘satisfying’ rather than ‘optimising’, as there is not a ‘unique’ or ‘optimal’ 
answer to the problems raised.  Hence, for the purpose of strategic management in highly 
dynamic complex systems such as coastal zones, adequate techniques are required that 
support and stimulate the decision maker in recognising actual problems and anticipating 
future ones, and that permit him to formulate and test possible solutions to assure a ‘safe’ 
future for the system.  For such exercises --and despite the fact that they are not typically 
used in DSS-- simulation models are effective means (Boersma, 1989), because: 
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• they permit to represent complex situations that are beyond the reach of the operations 
research and analytical methods typically used in DSS; 

• they permit an intuitive, plastic representation of reality, thus providing a better 
insight in the actual decision domain and the particular decision situations; 

• they permit to calculate alternative, comparable futures, thus constituting an 
instrument to investigate the likeliness of a desirable situation through 
experimentation. 

But, simulation models remain poor decision tools, in the sense that they are not goal-
directed.  Rather, an initial condition, along with constraints on the model, is solved and 
propagated forwards in time.  By means of ‘What-if’ analysis, the user is to change the 
initial state, or the constraints, until the model produces a desirable final ‘goal’ state.  It 
is by no means certain that this goal state can or will ever be reached, nor is it very clear 
why it is or is not reached.  Future research in the field should focuss on the development 
and inclusion in the DSS of tools that extend simulation models beyond ‘what-if’ in the 
sense meant by Rothenberg (1989).  The application of multi-objective and multi-criteria 
methods on simulation results will certainly help in the decision making process, while 
the application of techniques such as Constraint Satisfaction, Genetic Algorithms and 
Neuro-computing might reduce the potential search space substantially. 

1.2. Modelling and decision making philosophy 

At the centre of the methodology propagated by RAMCO, is the idea that a good policy is 
first of all a policy based on the right information and sufficient knowledge about the 
system for which it is intended.  This can only result from a thorough understanding of 
the network of processes in which the policy maker intervenes. Policy makers face the 
difficult task of interfering in processes that are very complex in nature because of their 
interconnection and interrelation. In order to help the policy maker see through this 
complexity, RAMCO offers him a system model incorporating as much as possible of the 
essential linked processes and representing reality as faithfully as possible. This is a 
fundamental scientific approach in which ‘learning about the behaviour and dynamics of 
the system’ rather than ‘finding a specific solution’ is the most important incentive for 
the development of models and Decision Support Systems. Thus, it is important to 
carefully represent these sections of reality as faithfully as possible. The knowledge and 
the model outline determine the nature and quality of the outcome of RAMCO. Four 
aspects, in particular, are prominent: 
 
1. Policy makers intervene in complete systems. Although they are supposed to 

intervene in systems with a view to their particular speciality or policy domain, they 
automatically intervene in other linked processes and may consequently cause 
unwanted (side) effects in the entire system. Conversely, problems that occur in 
particular parts of the system may originate from other parts of the system. This 
understanding, but also a better assessment of advisable interventions, can only be 
gained by using integral models --meaning complex coupled models--, which make it 
possible to understand the main driving forces within the system. 

 
2. Policy makers intervene in living systems which are never at equilibrium. Rather they 

are in a (thermodynamic) ‘far from equilibrium’ condition. Thus, policy makers 
intervene in a dynamic reality. Their interventions cause irreversable effects and 
even small interventions in the system can have unexpected and macroscopic 
consequences. These can lead to changes in the system in the short or long term 
(paradigm of self-organization, see for example Prigogine, 1981; Engelen 1988). 
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This requires strongly linked, dynamic models, to grasp the feed back loops and the 
complexity which characterizes reality. 

 
3. Policy makers intervene in spatial systems. In space, processes occur in more or less 

defined clusters of high and low concentration. Antropogenic and natural processes 
do not occur on average, neither evenly spread or constant in time. The detailed and 
changing spacing is controlled by the spatial interaction between physical processes 
and spatial (human) mobile agents. A true representation of a policy domain 
therefore requires spatial dynamic models. Literature shows that the robustness and 
succes of a spatial system (such as a coastal zone) particularly depends on its 
diversity, its complexity and its behaviour on a microscale. Policies can be more 
effectively directed if these microdynamics are better understood. Hence, they need 
to be represented in the decision instruments. 

 
4. Policy makers have to deal with uncertainty. Despite all scientific knowledge that is 

currently available, it has not been possible to accurately predict the behaviour of 
complex natural and antropogenic processes. It is possible, however, to make certain 
statements about the robustness of the behaviour of the system when it is disturbed 
by interventions. RAMCO supports an exploratory use of models. In this way it 
particularly helps to narrow down the number of possible interventions, without 
making a predictive statement about the only or optimal intervention. 

 
RAMCO uses integrated spatial models, in which natural, social and economic processes 
are fully linked on an appropriate detailed scale. It uses spatial information from GIS and 
(static and/or descriptive) GIS operations. The models are used to simulate reality and 
they show the user a glimpse of the future in all its complexity --either influenced by him 
or not. Time has the same meaning as in non-linear thermodynamics: there is only one 
calendar, one time loop, in which all processes occur simultaneously, and time runs 
clockwise only. This is very different from the classic mechanics based approach in 
which sub-processes are solved separately and sequentially: each sub-process produces 
an output which is passed from one sub-process to the next in a chain like fashion. In the 
latter approach, time is only an intermediate variable, which is set back and rerun for 
each sub-process separately. 
 
The knowledge contained in RAMCO is mainly available in the form of mathematical 
(sub-)models and algorithms. These sub-models fit into an integrated dynamic model of 
the coastal zone.  Although RAMCO calculates nearly the entire integrated model in the 
background, the user can limit himself to selecting those model components that are 
required to home in onto his problem.  The processes that remain in the background will 
make certain that the consistency in the system be maintained.  All the models used in 
RAMCO are fully documented in on-line documentation pages in which characteristics of 
the sub-models and their connection to the larger model are explained.  This transparency 
has been implemented with the aim of informing RAMCO users as completely as possible 
about the possibilities the system offered as well as on the details of the calculations it 
performs.  They also provide information on the source of the knowledge used and the 
hypotheses which underlie this scientific material. 

1.3. Policy analysis by means of RAMCO 

Inherent in the aims that lead to the development of RAMCO is the positivistic view that 
the use of scientific models and methods can improve the policy making process.  More 
in particular, RAMCO adheres to the view that better informed policy makers are better 
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equipped to make better policies.  Thus the role of the models and the Decision Support 
System is foremost awareness building and the education of the user, rather than support 
of the decision-making act itself.  The models therefore should give an adequate, truthful 
representation of the real world system, and the policy maker should be enabled to work 
with the models and the system in a well-structured, well-guided, transparent and flexible 
manner. 
 
The formal representation of the real world system by means of an integral model 
enables the user to work with it in a manner similar to what is common in process 
control. 

 
The coastal system (box: System) is represented by means of an integral model.  Due to 
its autonomous dynamics, this system will evolve into new states as time goes by (box: 
Resulting state).  The new state can be captured in a number of indicators.  When 
starting the exercise, the policy maker or coastal zone manager should have a clearly 
defined set of criteria expressing the desired state of the system at a particular point in 
time (box: Prefered state). 
 
In order to bring the actual state of the system closer to the prefered state, the policy 
maker can intervene in the system by means of policy measures (box: Policy measures).  
In an iterative process, he can tune his policy measures in an attempt to appraoch the 
prefered state with a minimum amount of intervention and costs.  The robustness of the 
chosen policy measures can be tested by imposing effects on the system which are 
beyond the control of the policy maker.  These effects are called scenarios (box: 
Scenarios) in RAMCO. 
 
In the RAMCO user interface, these different elements can be interactively consulted or 
specified from separate screens, each giving a specific view on the integral model.  See 
section 3.1.2. for more detail. 
 
We would like to draw the attention on the fact that the above scheme represents the 
loops in the learning process of the user.  It is too simple a scheme to represent the 
manner in which policy measures are designed, decided and implemented in reality.  To 
that effect, the model developed by Mintzberg (See for example Janssen, 1992) is much 
more useful. 

1.4. Model integration and model implementation 

At the very hart of RAMCO is an integral model representing the physical, 
environmental, economic and social processes that typify the dynamics of a coastal zone 
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generally and the coastal zone of SW Sulawesi in particular.  In order to develop this 
type of integral model, use is made to the extent possible, of existing scientific 
knowledge, methods, models and databases.  Existing models dealing with physical, 
ecological and socio-economic aspects of coastal zones have been reviewed and adapted 
in view of their integration into a multi-scale, multi-temporal dynamic modelling 
framework.  This activity requires to pay attention to the scientific, practical and 
technical aspects of model integration (Engelen et al., 1999).  But, despite the fact that 
the terms ‘integral model’ and ‘integrated model’ are used all over the literature, and 
despite the fact that the use of integrated models is strongly advocated in disciplines such 
as Integrated Assessment (see for example: Gough et al., 1998), very few recipes or 
procedures for model integration are available from the literature.  Model integration 
seems more an art than a science at this moment: 
 
Scientific integration, we believe, is about what can and what cannot be integrated from a 
scientific point of view.  It involves constraints on the type of models (for example: 
qualitative vs. quantitative, dynamic vs. static, etc.) on the temporal dynamics and time 
scales, on the spatial dynamics and spatial resolutions, on the details that matter, and on 
rigorous methods for aggregation and simplification. 
 
Practical integration deals with the end-use and the end-user of the model.  It seeks an 
answer to the questions: what is useful to be integrated with a particular end-use in mind 
and what are the needs, expectations and constraints of the end-user?  It is the experience 
of the authors that public policy problems are often ‘complex problems’ rather than 
‘complicated problems’, meaning that the problems touch the near complete system, but 
could be given an adequate answer if a limited formal description of the whole system 
would be available.  As a result, we believe that the development of an integral model 
will foremost involve a simplification and aggregation effort in order to enable policy use 
of models that have been developed most of the time for research purposes. 
 
Technical integration deals with the ways in which existing models, their software 
representation, databases, user-interfaces, input and output devices can be coupled into a 
single system, running on the end-user’s computer platform.  In the computer sciences, 
technical integration has been given a lot of attention.  It has become much easier, at least 
for the technicians among us, and should no longer be the limiting factor in the 
development of a usable integral model. 
 
From a computer science point of view, integration of models is very much a problem of 
software component integration.  Software components are pieces of software that are 
designed for re-use.  The ideal software-component is platform independent and can be 
plugged into a software system like a plug into a socket.  In the last decades, several 
software component technologies have been developed; some of which are platform 
independent.  On the PC platform, on which RAMCO runs, one of the first successful 
component technologies was the Dynamic Link Library (DLL): a file with executable 
code that is easy to distribute and re-use.  The main drawback of the DLL is the lack of 
structure, which prevents an application from verifying whether it uses the DLL in the 
correct way.  Compared to DLL’s, VBX’s have more internal structure.  They are easy to 
develop in Visual Basic and were mostly used to build small supporting graphical 
applications, called controls, and abbreviated as X in “Visual Basic X”.  Their main 
drawback is the inherent 16-bit technology on which they are based.  A heavyweight 32-
bit version of VBX is OCX, but the latter software components are notoriously difficult 
to develop.  ActiveX (Rogerson, 1997) is the latest software component technology 
developed by Microsoft.  It concerns a ‘light’ version of OCX.  It was mainly the need to 
create small interactive web pages on machines running Microsoft Windows that led to 
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the development of ActiveX, because small ‘active’ controls were needed as part of a 
web page.  Hence each interactive control became an ActiveX software component.  
ActiveX is supported very well by the Microsoft Development Studio toolkit, which 
enables to build ActiveX components in C++, Visual Basic or Fortran within minutes. 
 
In the future, RAMCO will use more extensively the ActiveX technology.  In order to 
incorporate existing models in RAMCO, they will need to be represented as ActiveX 
components.  With a view to change the software code of the existing models as little as 
possible, the models are ‘wrapped’ into a piece of intermediate software code (called 
‘wrapper’), which will make them look like ActiveX’s from the outside. 
 

An ActiveX / RamCo wrapper is put around each
existing model 'XYZ'. This wrapper converts the

subroutines of model 'XYZ' on the inside into
ActiveX / RamCo subroutines at the outside

implementation of
existing model

'XYZ'
RamCo simulation

engine using
ActiveX

subroutines

subroutine
declarations of

ActiveX / RamCo
components

subroutine
declarations of

existing
model 'XYZ'

 
Clearly, the typical user of the RAMCO modelling shell or Decision Support System 
would be served best if he could compose, exchange and re-arrange sub-models as easily 
as Lego building blocks and develop his model from a set of exchangeable and 
interchangeable Model Building Blocks (MBB), each representing an autonomous 
process which is executed at its characteristic time step and geographical scale.  The 
‘wrapping’ technique is applied to each unit, and the RAMCO simulation engine takes 
care of the linking, time keeping, synchronisation and data management and of the units. 

1.4.1. RAMCO’s simulation environment 

In order to develop and adapt integral models in as flexible a manner as possible, 
RAMCO features an Object-Oriented (O-O) simulation environment and simulation 
language.  The objects are the so-called Model Building Blocks (MBB’s).  MBB’s are 
more or less complete models.  They vary from simple mathematical operators, such as 
Multipliers or Adders, to rather sophisticated and nearly complete models consisting of 
coupled mathematical equations performing sophisticated calculations. 

 
A Model Building Block represents a portion of the model: an action or process.  Each 
MBB is represented by means of a unique graphical object that shows how the MBB 
relates and is connected to other MBB’s in the model.  From this connection scheme, the 
MBB knows where it has to get its input from, and where it has to send its output to.  
MBB’s may simply represent sources of information (i.e. entered from file or by the 
user), other will transform information as it passes through them, and still other will 
simply serve to communicate, in a synthetic manner, the outputs of the model to the user.  
Despite the fact that all these MBB’s play different roles in the model, in Object-oriented 
jargon, they are all ‘children’ of the same ‘parent’, which is essentially a MBB capable 
of exchanging and transforming information. 
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Next to the Model Building Blocks, RAMCO’s simulation language features a number of 
additional primitives: In-Connectors through which MBB’s obtain data from other 
MBB’s; Out-Connectors through which MBB’s send out their output for use in other 
MBB’s; Connections that link the MBB’s; Dialogs through which the MBB’s 
communicate with the user; and Documentation pages containing the technical 
specifications of the MBB’s. 
 
Libraries are repositories of MBB’s.  The entire definition of the MBB (its code, its 
graphical representation, its dialog, its connectors) are stored in the Library.  When a 
MBB is included in a model, the block itself is not copied to the model, rather a reference 
to the block in the library is made. 
 
SuperMBB’s group a number of interrelated and linked MBB’s that form a logical entity.  
They are introduced to keep the representation of the model structured and clear. 
 
Every MBB has one Dialog associated with it.  Dialogs are used to enter MBB specific 
information, such as the parameter values and the initial values of the state variables of 
the model.  While the simulation is running, dialogs return the updated values of output 
variables to the user.  Entering data in dialogs is done in a manner which will support and 
protect the user to an extent, because each edit box in a dialog window knows what type 
of data it should get from the user: a single number, a set of numbers, or a table (i.e. time 
series).  For each type the appropriate editor is opened when the user clicks in the edit 
box. 
 
Each MBB has its Documentation page in the Documentation system.  It is accessible 
when the dialog window of the MBB is opened (by pressing the F1-key or clicking in the 
dialog window by means of the Context Sensitive Help cursor).  This Documentation 
page gives technical information about the MBB.  It can include the mathematical 
expression, scientific references, the specification of the In- and Out-Connectors, etc. 
 
A model block has a so-called In-Side and an Out-Side.  The In-Side is where the In-
Connectors are placed, the Out-Side is where Out-connectors are placed.  Each of the 
four edges of the MBB can be the In-Side or the Out-Side.  The only limitation is that the 
In-Side and the Out-Side of an MBB can never be on one and the same edge. 
 
In future versions of RAMCO the modeller will be enabled to manipulate the objects by 
means of a graphical editor.  He will place the Objects on the screen and connect them to 
each other in order to create a consistent and coherent model. 
 

Model Building Block

In-Connector 

Out-Connector Connection 
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1.4.2. Levels of spatial dynamics 

One of the unique features of RAMCO is its capability to deal with spatial dynamics at 
different levels within the same integral models.  More in particular RAMCO models will 
generally have two strongly coupled components: one for macro-level, long range and 
large scale processes and a second one for processes operating on the micro-level, short 
range, and micro-scale.  Sub-models will in general operate at one level, but may 
exchange information with sub-models at the other level. 
 

 
 
At the macro-level, the model integrates several component sub-models, representing the 
natural, social and economic sub-systems of the coastal zone.  These are all linked to one 
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another in a network of mutual, reciprocal influence.  The macro-level allows for the use 
of regionalised representations and for different types of mathematical representations 
thus permitting a more or less detailed modelling of various aspects of the sub-systems as 
required for specific applications. 
 
The micro-level models are cellular models: they are developed on a cellular aray of 
identical cells.  At this level RAMCO supports the use of models that are based on the 
theory of Cellular Automata (CA).  Cellular Automata are mathematical objects that have 
been studied rather extensively in mathematics, physics, computer science and artificial 
intelligence (Gutowitz, 1991), but, until recently they were best known as games 
(Gardner, 1970).  Tobler (1979) defined them as ‘geographical models’, but only recently 
have they been applied in the spatial sciences (e.g. Couclelis, 1985, 1988; Engelen et al. 
1993, 1995, 1996; White and Engelen, 1994, 1997a, 1997b). 
 
A cellular automaton consists of an array of identical cells in which each cell can assume 
one of a discrete number of possible states at any one point in time.  Time progresses in 
discrete steps, and all cells change state simultaneously as a function of their own state 
and the state of the cells in their immediate neighbourhood and defined in a set of state 
transition rules. Flow and diffusion processes require spatial contiguity in order to take 
place, since the interactions consist of point to point spread: water currents carrying 
sediments from one cell to the neighbouring cells, or seeds spreading from one site to 
another.  They can be represented in a fairly simple CA model defined in terms of the 
Moore neighbourhood, consisting of a cell an its 8 nearest cells.  But, socio-economic 
interactions take place over distances beyond the nearest neighbours, and 
neighbourhoods of a larger size are required to model them adequately.  As a result, the 
neighbourhood of the land use model in RAMCO is a circular template consisting of 197 
cells at the maximum. 
 
Except for purely theoretical problems (See for example: Gardner, 1970; White and 
Engelen, 1993), spatial problems are set in spaces that have idiosyncrasies and 
heterogeneities at all levels of detail.  In RAMCO heterogeneities have been introduced 
on the level of the individual cells of the cellular space.  The apparent similarity of 
cellular spaces with raster based GIS systems led us to define these in terms of 
geographical factor maps (Wright, 1990) and derived suitabilities and accessibilities.  
This allows us to introduce physical, environmental, institutional and historical 
characteristics in dynamic models at high levels of spatial resolution. 

1.4.3. GIS component 

RAMCO can handle cellular models with dimensions up to 500 by 500 cells.  In its actual 
form, it is most useful for modelling problems on grids which resolution varies from 50 
to 500 meter. RAMCO has all the facilities required to be used as a stand-alone 
application: it has all the editors required to enter new or to modify existing information, 
it permits to import GIS data and to export its (geographical) output to GIS systems.  In 
particular RAMCO has been equipped with the necessary data-translators to exchange 
information with IDRISI for Windows (Eastman, 1995).  IDRISI offers all the 
functionalities required to import, enter or prepare the data for RAMCO’S micro models, 
and it offers a number of tools to further analyse the map output generated by RAMCO.  
IDRISI for Windows has been selected because: 
1.  it is a raster based GIS, and thus fits the cellular paradigm by design; 
2.  it makes use of standard file formats and thus permits the exchange of information 

with other GIS packages; 
3.  it is easy to use and runs on most PC’s under Windows; 
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4.  it is updated on a regular basis; 
5.  it is very well documented and widely used, both for training and policy making; 
6.  it has been selected by UNEP and UNITAR as the system for use in developing 

nations; 
7.  it is very reasonably priced. 
It could be envisaged to include in the future versions of RAMCO aditional data 
translators to exchange GIS information with other commercial GIS packages. 

1.4.4. DDE link with Excel. 

With the aim of increasing RAMCO‘s level of re-usability and flexibility, the possibility 
has been built-in to link it to Microsoft Excel.  More in particular there exists a DDE link 
between RAMCO’S Simulation Environment and Excel.  In this prototype, the link is one 
way: at each simulation time step, RAMCO sends a row of data to a predefined Microsoft 
Excel Workbook.  These data –updated values of the goal variables-- are available to the 
user during and after the simulation and he has the full functionality of Microsoft Excel 
at his disposal to work with them.  Hence he can store the results or perform more or less 
sophisticated operations on the data using the evaluation and optimisation algorithms 
available in Microsoft Excel. 

1.5. Future developments 

Decision making with RAMCO will be to an extent a collaborative effort involving three 
distinctive types of users.  For the sake of clarity we name them: Modeller, Analyst and 
Policy Maker.  It is not excluded that different types are unified in one and the same 
person, but, given the specific technical and context knowledge required from each, it is 
more likely that this is not the case.  This version of RAMCO does not as yet feature the 
full functionality required to support each of the users entirely.  In particular the editors 
required to alter the models are not as yet available to the Analyst and the Policy maker.  
However, later versions are intended to evolve into the general direction outlined below. 
 
The Modeller is furthest away from the actual policy making process.  He is the most 
technical type and responsible for the development of the Model Building Blocks 
(MBB’s) that are stored in the MBB-Libraries.  This user has the knowledge and skills 
required to translate technical and conceptual problems posed by the Policy maker and 
the Analyst into quantitative models, algorithms and new building blocks that are missing 
in the existing MBB-libraries.  Next he is capable of implementing the algorithms into 
executable software code which respects the guidelines, templates and interfaces that 
Active X component technology imposes. 
 
The Analyst is capable of building integrated models by means of the Model Building 
Blocks which he selects from a MBB-Library.  To that end he will need to have a good 
knowledge of the processes in coastal zones and of the state of the art scientific 
knowledge about how to represent them formally.  He will have to be familiar with the 
Model-editor of the RAMCO simulation environment.  The analyst will possibly 
personalise dialogs as well as Documentation pages.  He will calibrate the models which 
he builds and will define the ranges of parameters and variables as well as the initial 
conditions and the default values.  He is sufficiently familiar with RAMCO, the IDRISI 
GIS system and MS Excel to prepare (import and export) map information and possibly 
to customise the output of the system.  The Analyst and the Modeller have access to all 
the facilities offered by RAMCO.  Thus, they can overrule the parameter settings and 
ranges of all kinds. 
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The Policy maker is the final user of the system.  He will work with the fully prepared 
and calibrated version of an integral model, coupled as it might be with the GIS, 
Microsoft Excel or the ANALYSE program.  He will have the possibility to change 
parameter and variable settings within the (save) ranges set by the Modeller and/or the 
Analyst.  He will have full access to the different views of the model, to verify values of 
intermediate and state variables, but he will work mostly with the views Scenarios, 
Policy Options and Policy Impacts as they have been designed and prepared specially for 
him. 
 
If we define Integral Assessment as ‘the exercise aimed at getting a good understanding 
of the coastal system as a holistic, integral system, in order to identify the major driving 
forces and to detect the faults therein’, then it is likely to state that the Analyst in 
collaboration with the Policy maker are the primary users of the RAMCO system.  
Eventually they should be able to quickly set-up the system for a specific case and should 
be able to share their views through hands-on experiments with stakeholders, even with 
the public at large. 
 
Developing a new application with the RAMCO DSS will in most cases start with a 
discussion between the Policy maker and the Analyst.  The Policy maker will pose the 
specific policy problems he is faced with.  He will define the policy measures that are to 
be tested, the external influences that have an impact upon the system and the 
performance indicators and criteria which he wants to incorporate in the evaluation 
process.  Next, he might be able to present a first analysis of possible cause and effect 
loops that typify the coastal system.  In the best of cases, the Analyst will be able to 
select an existing integral model which has been implemented in RAMCO and adapt it to 
represent the new problem adequately.  To that end he will use a graphical model editor, 
remove obsolete MBB’s from the model, select new MBB’s from the MBB Libraries and 
connect them with the other MBB’s of the model.  If the new model requires MBB’s that 
are not as yet included in an MBB Library, then the analyst will request a Modeller to 
develop such a MBB for inclusion in the MBB Library and his model.  The Analyst will 
gather the data for the model.  Part of these consist of geographical data which he can 
import from existing GIS systems or enter them by means of RAMCO’s GIS facilities.  
He will calibrate his new model and test its sensitivity.  From these exercises he will 
obtain the default values and ranges for the parameters and state variables, which he 
enters into the system.  Once the models have been fully calibrated, the system can be 
handed to the Policy maker.  He can design and run alternatives and evaluate their 
relative merits in meeting the policy goals which he has set. 
 
It is obvious that the steps described above are not run through in a linear and sequential 
manner, rather an iterative and cyclic process is more likely.  Also the interplay between 
the different users will be more lasting than suggested. 
 
One of the very great merits of RAMCO is the manner in which it could gradually evolve 
into a storage tank of coastal zone management knowledge.  Indeed, as a result of its 
application to coastal zones worldwide, its MBB-Libraries and Model bases will grow, 
till a point where many of the processes typifying coastal zones will have a formal 
representation available from the MBB Libraries.  From this, we imagine that specific 
Libraries could be developed --similar to the engineering and manufacturing fields-- that 
will group the MBB’s required for specific coasts, such as: Tropical coasts, Arctic 
coasts, Sandy coasts, Strongly urbanised coast, etc. 
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1.6. The case South-West Sulawesi 

In order to demonstrate the capabilities of RAMCO in addressing Coastal Zone 
Management problems, a case has been implemented.  It concerns a coastal zone in 
South-West Sulawesi (Indonesia) centred around the city of Ujung Pandang.  This region 
suffers of a number of typical problems, which can be addressed by means of RAMCO.  
A short description of the problems is given here.  This section is based on: J.L. de Kok 
and Wind H.G., 1996; ‘Towards a Methodology for Sustainable Coastal Zone 
Management, A Case Study for South-West Sulawesi’, Twente University, the 
Netherlands, and J.L. Kok and Wind H.G., 1999; ‘Methodology for Sustainable Coastal 
Zone Management in the Tropics, The Integrative Research’, Twente University, the 
Netherlands.  For more ample information on the case study, we refer to the original 
publications. 
 

 
1. Urban growth: 
The total population size in the study area outnumbered 2 million people in 1994, half of 
which is living in Ujung Pandang, the main city in the region.  The annual population 
growth of this city in the period 1984-1990 was 4.7 %.  Major projects are ongoing and 
planned to develop the urban area: expansion of the harbour, the airport and the nearby 
industrial site.  Thus the city will continue to exert a major drawing force on the rural 
area.  Its population size is expected to double in the next 20 years.  This causes major 
pressure on the land in the coastal fringe, but also causes problems related to waste 
generation. 
 
2. Aquaculture: 
Along the coastline, most of the mangroves --providing a natural coastline protection-- 
have been cut to be replaced by brackish-water ponds (called tambaks) to grow fish, 
prawns and seaweed.  The main driving force of this mechanism is the export market 
which is an important source of foreign currency.  For S.W. Sulawesi Aquaculture in 
tambaks now represents 70% of the total monetary production of the fish sector.  The 
tambaks, which often use the tidal action for waste discharge, also form a major source 
of coastal waters pollution due to the intensive utilisation of antibiotics and overfeeding 
of the prawns. 
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3. Intensified Agriculture: 
The introduction of new high-yielding rice varieties and increased use of fertilisers 
exacerbate ground- and surface water pollution.  The productivity of the rice fields 
almost entirely depends on the amount of irrigation.  The runoff of fertilisers and 
pesticides affects the quality of the water used for nearby tambaks. 
 
4. Erosion in the upland area: 
The catchment area upstream the Bili-Bili dam is characterised by considerable soil 
erosion, increased by intensive land-use for horticulture products and large scale forestry.  
Without proper counter measures, the resulting runoff of sediments can reduce the life 
time of the reservoir.  Moreover the degradation of cultivable lands has lead to the 
expulsion of labour.  This makes more and more people dependant on marine resources 
for their livelihood or causes people to migrate to the city for their survival. 
 
5. Bili-Bili dam and Jeneberang river: 
The main purpose of the dam is to prevent the city from flooding by the Jeneberang river 
during the wet season.  The reservoir will contribute to the solution of the municipal 
water shortage in Ujung Pandang.  At present, less than 50 % of the demand is met by the 
municipal supply.  It is improbable that the water supply from the reservoir will be able 
to keep up with the rapid growth of the city.  Irrigation and hydropower are competing 
for water use.  Downstream of the dam problems can be expected as most of the sediment 
in the Jeneberang will be intercepted by the dam, the amount of sediments transported to 
the coast is expected to reduce with 80%.  This may result in coastal morphologic 
changes of the land north of the river mouth.  On the other hand, the near to the coast 
coral reefs and seagrass meadows will be less affected by terrigene sedimentation due to 
the decreased discharge of the Jeneberang river. 
 
6. Tourism in the delta: 
S.W. Sulawesi is not as yet a major destination for domestic and foreign tourists.  The 
regional authorities are planning to develop local tourism and recreation.  North of the 
river mouth an area of 1000 ha has been given a tourism destination.  The possible 
morphological changes of the river delta, the problems caused by the increasing pollution 
and the risks for flooding have not been taken into consideration sufficiently. 
 
7. Over-exploitation of marine resources: 
As the population of the coastal zone traditionally depends very largely on fish for its 
food and proteine intake, the fish stocks in the strait of Makassar are strongly subject to 
overfishing.  This problem has become a severe one, and plans have been made to create 
a marine park where fishing is forbidden in oder to allow the fish stocks to recover 
somewhat.  Meanwhile, dynamite fishing is still practiced in the Spermonde archipelago, 
which causes substantial damage to the coral reefs and the depletion of the fish stocks.  
Moreover, the urbanisation process is accompanied by large scale infrastructural 
developments and construction activities, which leads to an increasing demand for 
construction material.  Coral reefs provide a cheap base material for the cement.  This 
coral mining takes place around the islands in the reef zones of the Spermonde 
archipelago. 
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2. Getting Started 

This chapter explains how to install RAMCO on your computer and how to start the 
program.  It also describes the main features of the graphical user interface. 

2.1. What is included in this demo package ? 

The RAMCO demo package consists of this printed document and two 1.44 Mb diskettes 
labelled RAMCO disk 1/2 and RAMCO disk 2/2.  On RAMCO disk 1/2 you will find a 
series of compressed files and 1 executable Setup.EXE that is used to install RAMCO. 

2.2. Installing RAMCO: Hard- and Software Requirements 

RAMCO runs on personal computers equipped with an Intel 80486 or Pentium processor.  
To use RAMCO, your computer should have the following hardware components: 
 
• At least 16 Mb of RAM (32Mb recommended) 
• A hard disk with at least 4 Mb free (for RAMCO only) 
• A SVGA video card and screen (recommended: resolution 1024*768 pixels, 16 

colours, size 17 inch or more) 
 
To run the application and the exercises which we describe and provide the files for on 
the demo diskettes, you should have the following software packages installed on your 
computer: 
 
• Microsoft Windows 95/98/NT 
• Microsoft Excel (version 6.0, or later) (optional) 
• IDRISI for Windows (version 1.0, or later) (optional) 
 
Contrary to the older versions of RAMCO, it is no longer possible to run this version 2.0 
under Windows 3.x. 

2.3. Installing RamCo: Installation procedure 

The following is a description of the step by step installation of the RAMCO.  The 
installation/uninstallation of RAMCO follows the standard for Windows 95/98/NT. 
 
If you have a previous version of RAMCO software installed on your machine, it is better 
to uninstall it first. If you would want to keep it, make sure to put (this new version of) 
RAMCO in a separate directory. During the installation you may encounter a message 
asking whether you want to keep or replace certain files. It is prefered to replace them for 
use with RAMCO.  Keeping the old files may cause malfunctioning of the software. 
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1 Start Microsoft Windows 95/98/NT. 
2 Insert the disk labelled "RAMCO disk 1/2" into the drive. 
3 Click the Start button in the Windows 95/98/NT Task bar.  Move the mouse pointer 

to the Settings command and move on to the Control Panel option.  As a result the 
Control Panel dialog box will open.  Select from the list Add/Remove Programs 
by double clicking it.  Next click the Install button in the Install/Uninstall view of 
the Add/Remove Programs dialog box. 

4 Next, the Windows 95/98/NT installation program will be started and will request 
you to click the Next button until (1) the program has selected your disk drive as the 
installation medium, and (2) until it will have found on the diskette the Setup.EXE 
program for RAMCO.  Then, the command line "a:\setup.EXE" will appear in the 
edit field of the install window.  Hit Finish to have the program continue the 
installation. 

5 Continue clicking “Next” until the “Read Me” screen appears. Make sure to read 
this page. After clicking “Next” again, a second dialog box appears asking you where 
to install RAMCO. You can accept the default path, which is “c:\RamCo” or replace 
it in the edit box by one of your own choice. You may use the “Browse” button to 
select this alternative path as well. 

6 To go on, press the "Next" button.  Otherwise to cancel the installation process, press 
the "Cancel" button. The installation program will ask you whether the programme 
must be installed for Windows 95/98/NT or Windows 3.x. Select RAMCO for 
Windows 95/98/NT. 

7 Next the installation program suggests to add RAMCO to the new Program Group 
RAMCO.  You are free to create another Group or to choose an existing one from the 
list shown. 

8 From that moment the installation application is decompressing the necessary files 
and puts them in the directory structure of RAMCO.  At a certain point in time you 
will be asked to insert disk #2 in the drive.  Insert at that moment the disk labelled 
“RAMCO disk 2/2”. 

9 If everything went OK, a last dialog box will inform you about the fact that the 
installation is finished.  Once the installation on the hard disk is completed, the 
program creates a group named “RAMCO” under the Start button and Programs 
command.  It contains an item labelled “RAMCO”.  When you double click this item, 
RAMCO will be started and the “About” window will appear.  Click “OK” to enter 
the Application window. 

2.4. Starting RAMCO 

Once installed, you can start the RAMCO application as follows: 
 

1 Start Microsoft Windows. 
2 Under the Windows 95/98/NT Start button and the Programs group, you will find a 

group called RAMCO.  Double-click on the RAMCO icon in the RAMCO group. 
3 RAMCO will be started and you will see the RAMCO Application window on your 

screen. 

2.5. Screen Layout 

When you start RAMCO, you will enter immediately in the Application window of the 
simulation environment.  This is the window in which you will run your models.  Before 
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a simulation file is opened, the screen is empty except for its top part.  Below we will 
describe the different components of this screen. 
 
 

 
 
 

2.5.1. The Control Menu box 

The Control Menu box contains the Application window Control Menu, which controls 
how windows are arranged on the desktop.  The list below summarises the Control Menu 
Commands. 
 
Use this command To … 
Restore restore the window to its previous size 
Move move the window using the arrow keys. 
Size change the size of the window. You can use the mouse or the arrow keys 

to change the size. 
Minimize shrink the window to an icon 
Maximize enlarge the window to the full size of the screen 
Close close the application window 

 

2.5.2. The Caption bar 

The Caption bar, also called Title bar, of the Application window displays “RAMCO”. 
 
To the left of the Caption bar three buttons are positioned that enable you to re-size the 
Application window. 

• The Minimize button allows you to shrink the window to an icon (same as Minimize 
in the Control Menu box); 

• The Maximize button allows you to enlarge the application window to the full size of 
the screen (same as Maximize in the Control Menu box); 

• The Close button allows you to close the application window, and thus quit the 
application (same as Close in the Control Menu box) 

2.5.3. The Menu bar 

The Menu bar of the Application window contains RAMCO’s main Menu.  The 
commands are logically organised in the menu so that you will quickly become 

 

Status bar 

Control Menu box Menu Bar Caption Bar 

Tool bar 

Application Window 



 

RamCo User Guide - Version 2.0 June 1999 Page 22 

comfortable with the various functions of the program.  The menus are summarised in the 
table below; subsequent chapters elaborate on the description.  Chapter 4 gives an 
overview of all menu commands. 
 
Use this menu To … 
File manage your simulation files.  The printing facilities are also located in this 

menu, and if you want to exit the program, you can do it from here. 
Edit edit the maps that are part of the micro-scale model.  All commands for 

editing are located here.  Depending on the type of map that is active, the 
appropriate edit features are listed and accessible. 

View change the way a map is displayed.  Commands to zoom in and out as well as 
commands to display information on the foreground or background of the 
maps are part of this menu. 

Maps open a new window with one of the maps of the modelled region. 
Rules define the model at the micro level by means of defining the Cellular 

Automata transition rules. 
Simulation control the simulation.  The commands in this menu are the same as the ones 

represented by means of buttons in the Tool bar. 
Options customise the workspace.  Commands permit among others to display or 

remove the Status bar and/or Tool bar, and to (DDE) link the simulation 
package to Excel. 

Window manage your windows on the screen  
Help invoke the on-line Help facilities. 

2.5.4. The Tool bar 

The Tool bar, also known as Speed bar, gives a faster access to some of the more 
frequently used commands which are also accessible via the menu. 
 

 
 
Use this Button To … 

 
open a simulation file from the disk. 

 
save a simulation file to disk. 

 
change the pointer to a pen.  The pen is used to pick a value from the legend 
and enter it in a cell on the map. 

 
change the pointer to a bucket.  The bucket is used to pick a value from the 
legend and enter it in larger, contiguous areas of the map. 

 
change the pointer to a ruler.  The ruler is used to enter detailed information 
cell by cell.  When a cell is clicked, a dialog will open to enter the exact 
value. 

 
zoom-in.  Increase the size of the map on the display. 

 
zoom-out.  Decrease the size of the map on the display. 

 
advance the simulation with one simulation step (as set with the Steps... 
command). 

 
advance the simulation till the next pause is reached (as set with the Pauses 
... command). 

 
stop the simulation. 

 
reset the simulation.  State variables and maps take their initial values, 
parameters keep their actual values.  
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Use this Button To … 

 
print the Micro-scale dynamics window.. 

 
access the context sensitive help cursor.  The next click action on a 
command will invoke the context sensitive help on this command. 

 
Next to this set of buttons, the Tool bar also displays the simulation clock.  Each time 
step, the clock is updated. 

The left most figure indicates the years simulated (range: year 0 till year 25), while the 
right most figure is the month within the year (range: month 1 till month 12) 
 
The Tool bar command in the View Menu allows to display or hide the Tool bar in the 
RAMCO Application window. 

2.5.5. The Status bar 

The Status bar is displayed at the bottom of the Application window.  This zone provides 
information to the user on his actions while he is working with the application.  The left 
area of the status bar describes actions of menu items as you use the mouse or arrow keys 
to navigate through menus.  This area similarly shows messages describing the actions of 
toolbar buttons when pressed.  The right area of the status bar indicates which of the 
following keys are latched down: 
 
Indication Description 
CAP The Caps Lock key is latched down. 
NUM The Num Lock key is latched down. 
SCRL The Scroll Lock key is latched down. 

 
The Status bar command from the View Menu allows to display or hide the Status bar in 
the RAMCO Application window. 

2.6. Getting Help 

RAMCO comes with a very concise on-line Help facility.  Its structure and operation is in 
accordance with the Microsoft Help standards.  Hence, using Help should pose no 
problems for those familiar with Windows. 
 
To get Help, press “F1” or the key sequence ALT-H 
 
The Help menu has 3 items: 
1 “Index” gives an access to the index of the help guide. 
2 ”Using Help”, gives the general instructions on how to use the Windows Help 

System. 
3 “About RAMCO ...", gives information about the version of RAMCO that you are 

working with. 

2.7. Exiting RAMCO 

Closing RAMCO is simply done by selecting the Exit command from the File menu.  If 
you have simulation files open when you select Exit, the application will ask whether 
you want to save simulation results.  If you confirm to be interested in saving results you 
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will get the Save dialog box.  More information on saving simulation results is given in 
the next chapter. 

2.8. If you experience problems 

If you experience problems in installing or running RAMCO 2.0, contact: 
Research Institute for Knowledge Systems bv. 
To the attention of Inge Uljee or Guy Engelen 
P.O. Box 463 
6200 AL Maastricht 
The Netherlands 
Tel: +31 43 388.33.22 
Fax: +31 43 325.31.55 
E-mail: info@riks.nl 
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3. Running SW Sulawesi Simulations 

This chapter describes how to run simulations with RAMCO.  No details will be given on 
the model for South West Sulawesi which comes with this demo version of the RAMCO 
Decision Support environment.  For details about the model, we refer to: ‘Methodology 
for Sustainable Coastal Zone Management in the Tropics, by Jean-Luc de Kok and 
Herman G. Wind, Department of Civil Engineering Technology & Management, Twente 
University, Enschede, The Netherlands,1999.’ Also the on-line model documentation 
contains a lot of detailed information about the model (see section 2.1.2 Dialog boxes). 
 
In the previous chapter we explained how to install and run RAMCO.  We assume from 
now on that you have read this information, that you have knowledge of the different 
technical terms introduced, and that you have successfully installed RamCo on your 
computer. 

3.1. Running a simulation 

Click the Start button in the Windows 95/98/NT Task bar and point the cursor to 
Programs group.  Move through the cascading menu into the RamCo group and open 
RAMCO by clicking the RAMCO icon.  If the software has been installed successfully, 
the Application window will open and the About information window will be displayed.  
Read the information in the About window and push the O.K. button (or the RAMCO 
icon).  Immediately the Open dialog box will open.  If not, push the Open Simulation file 
button. 
 
Look in the Open dialog box for files with a .SIM extension. 
 

By means of the 
standard Windows 
95/98/NT manipulations 
you can navigate 
through the directories 
on your hard disk, or on 
another computer in the 
network, in search of the 
simulation file of your 
choice.  Once the name 
of the file appears in the 
Open dialog box, select 
it and press the Open 
button or double click 
the file icon. 
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In fact the .SIM file contains references to all the files that are required to run a model.  
Later in this chapter we will give more detail about the contents and composition of the 
.SIM files. 
 
Once all files have been loaded, two windows will appear in the Application window: 
one titled Micro-scale dynamics and the other Macro-scale dynamics. 

3.1.1. The Micro-scale dynamics window 

The Micro-scale dynamics window is split into 3 viewing areas, called Panes.  Panes are 
separated from one another by means of Splitter bars.  You can displace the Splitter bars 
to change the size of the Panes.  To this end, position the cursor over the Splitter bar.  
The cursor changes to the Split Pointer (see Annex A for the meaning of the different 
pointer shapes).  With the left mouse button clicked down, the Splitter bar can be moved 
and the size of the Panes is adjusted accordingly. 
 

 
The Pane on the left of the Micro-scale dynamics window --called the Map pane-- 
contains a map representation of the modelled region.  More in particular the actual land 
use of the region as well as the position of coral reefs and seagrass beds is mapped.  For 
the sake of simplicity and clarity of this text, we will name sea, coral reefs and seagrass 
beds land uses. The legend of the map is displayed in the upper left pane --called Legend 
pane--.  The lower left Pane --called the Focus pane-- of the Micro-scale dynamics 
window shows the mapped region in small.  In the upper left part of this small map you 
will see a wire-frame (an inverted rectangle).  If the mouse is placed inside this wire-
frame, the frame can be moved while holding the left mouse button clicked down.  While 
the wire-frame is moved, you will notice that the focus of the map in the Map pane is 
changing accordingly.  The focus of the map can also be changed by means of the scroll-
bars of the Map pane.  The Legend pane too is equipped with a vertical scroll bar. 

Legend Pane 

Map Pane 

Focus Pane 

Splitter Bar 
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When the simulation is running, the Micro-scale dynamics window will be updated and 
the resulting land use will be displayed in the Map pane. 
 
The commands of the View Menu permit to change the manner in which micro-scale 
results of the model are displayed in the Map pane.  Display options include among 
other: Zoom in, Zoom out, and 3-D representation.  For a complete overview, consult the 
View Menu in section 4.3 of this User guide. 
 
Most of the functionality of the micro-scale models is accessible via the menu structure 
of the system.  Details on the different menu options is given in Chapter 4 of this guide.  
Here we will focus on a number of elements that are essential to understand the 
functioning of the micro-scale model and to change its parameters. 
 
The micro level model calculates and displays the changing land use (and sea use) of the 
coastal zone.  The legend of the map explains the meaning of the different colours.  A 
distinction is made in the model between the dynamic elements and the non-dynamic 
elements.  Dynamic elements are also called Land-use Functions and Sea-use Functions.  
The static elements are called Land-use Features. 
 

Sea Use Functions: 
Seagrass Coral Reef 
Land Use Functions: 
Agriculture Rice culture Shrimp culture Industry Tourism 
Urban residential Rural residentialt Mangrove Nature/forest 
Land Use Features: 
Sea Inland water Airport Harbour Beach 

 
Land-use Features will not change as the result of micro-scale dynamics.  That is to say 
they will not change location: they will not expand or will not disappear due to expansion 
of other activities.  Yet, they influence the dynamics of the Land use or Sea use 
Functions, and will interfere in the allocation process.  For example the Land use 
function ‘Tourism’ will be influenced by the presence (or absence) of the land use 
feature ‘Beach’. 
 
The dynamic behaviour in space and time is of Sea use functions Seagrass and Coral 
Reef is different from the other land use functions.  The specific details on their dynamics 
can be found in the documentation pages of the model (see section 2.1.2 Dialog boxes). 
 
The dynamic behaviour of the Land-use functions is based on a number of elements 
which can be changed (in principle at the least) by the user of the model: 
 
Cellular Automata Transition Rules. 
First and most important are the Cellular Automata transition rules.  They represent the 
dynamic element of the micro model (see for example: Engelen G., White R., Uljee I. 
and Drazan P., 1995; ‘Using Cellular Automata for Integrated Modelling of Socio-
Environmental Systems’, Environmental Monitoring and Assessment, 34, pp.203-214.).  
For each cell in the cellular space they will calculate how land uses will change 
throughout the simulation period.  The transition rules are accessible via the Rules menu.  
The rules are written as distance functions, expressing the manner in which land uses 
influence one another, stating whether they attract or repel one another in their vicinity.  
These rules are defined for each possible combination of land uses.  The model is very 
sensitive to the values entered for most rules.  Hence, changing rules can have dramatic 
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effects on the micro-scale dynamics.  We advice not to change the transition rules unless 
you have gained a lot of experience with running the model.  An overview of the 
complete set of rules can be seen when selecting Overview from the Rules menu. 
 
Next to the transition rules, the intrinsic characteristics of the cell itself will influence its 
potential for change to another land-use.  These are represented in the model by means of 
maps, namely the Elevation map, the Suitability map and the Network map.  All the maps 
are accessible via the Maps menu. 
 
Elevation. 
The elevation map is displaying the relief (above and below sea level) of the modelled 
region.  It is important for the model to the extent that land below sea level is not suitable 
for socio-economic use and that this land can not be allocated to one or the other land use 
activity.  Indirectly, the elevation will influence the suitability of a number of activities.  
Select Elevation from the Maps menu to have it displayed in a new window on the 
screen.  The View Menu allows to change the manner in which the map is displayed.  
The possibility exist to Zoom in, to Zoom out or to change the elevation categories with 
the Legend dialog box. 
 
Suitability. 
For each land-use function a suitability map is present in the model.  It shows how 
suitable each cell in the region is to receive that land use.  Suitability calculations are 
rather standard GIS operations.  Suitabilities are composite measures that involve the 
manipulation of so called Factor Maps.  A factor is a unique geographical attribute such 
as slope, soil type or vegetation cover.  Variations within a factor such as the degrees of 
slope, soil classifications or density of vegetation cover are referred to as factor types.  A 
factor map is showing the geographical location and distribution of factor types for a 
given factor.  Factor maps can be combined in various ways to generate a composite map 
depicting the relative capability of any given geographical unit to support a specific land 
use.  These composite maps are displaying the so-called suitability of the individual 
geographical entities (in our case cells).  In the SW Sulawesi model a linear combination 
of factors has been applied: the importance of a factor type (for a specific land use) is 
first rated and next, the factors are weighted and summed.  In Annex B an example of the 
factor type ratings and factor weights is given.  The suitability calculations are done in 
IDRISI for Windows and the resulting suitability maps are imported in RAMCO. 
 
The suitability map of each land use function can be selected from the Maps menu and 
the way the map is displayed can be altered by means of the View and Edit menu. 
 
Network. 
For each land-use function an accessibility map is present in the model.  It shows how 
accessible each cell is in relation to a network.  The network can be --in principle at 
least-- any network.  For the case of the SW Sulawesi model two networks are available: 
the road network and the irrigation network.  In this version of the model, the network 
included is the road network.  For some activities, such as tourism, the direct access to 
the road system is more important than for other, such as agriculture.  The maps are the 
result of an accessibility calculation done on the basis of the Accessibility parameters 
which are accessible via the Edit Menu. 
 
The user can freely open and close maps (except for the Micro-scale window).  We warn 
the user that opened windows are updated while the simulation is running and that this 
does take-up processing time, hence that the program will be slowed down. 
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More details on the use of Cellular Automata for modelling geographical phenomena at 
the micro-scale can be found in the publications in the reference list. 

3.1.2. The Macro-scale dynamics window 

The Macro-scale dynamics window is the graphical interface to the Macro-scale model.  
It consists of 4 Views, but will always show View # 4, the System diagram View, when a 
simulation model is opened.  The other Views are called: Scenarios, Policy options, and 
Impacts.  These names appear as the names of tabs which are positioned just below the 
Title bar of the Macro-scale dynamics window.  You can change the View by simply 
clicking the appropriate tab. 
 

 
Each of the Macro scale dynamics Views shows a specific graphical representation of the 
macro model: 
1.  the View # 4, System diagram View, shows an overview of the structure of the system 

modelled at the most synthetic level.  It allows access to all the details of the model at 
this level but also at lower levels.  You should learn to use it as a graphical explorer 
of the model. 

2.  the View # 1, Scenarios View, shows the parts of the model that are most subject to 
external influences and where hypothesis about these influences can be entered. 

3.  the View # 2, Policy options View, shows the parts of the model that are subject to 
policy interventions.  This is the View that will be used to select and typify the policy 
interventions that can be analysed with the simulation model. 

4.  the View # 3, Impacts View, shows the parts of the model that contain the summarised 
information and policy indicators to evaluate the impacts of scenario and policy 
options settings.  It is via this View that further information about indicators can be 
selected. 

 
In this prototype, the model structure, nor its graphical representation can be changed by 
the user. 
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A RAMCO model consists of Model Building Blocks (MBB’s) that contains the code 
required to calculate and execute mathematical operations varying from a single 
operation (such as the sum of two numbers) to a list of operations (set of mathematical 
equations).  MBB’s are connected to one another by means of MBB Connectors.  In 
order to improve the readability of the diagram, it is possible to group parts of the model 
into a SuperMBB and represent it in the diagram as a single block.  The diagrams in the 
different Views have been built by means of these primitives. 
 
Model Building Blocks. 
The diagrams in the different Views allow the user to understand the structure of the 
model and to access parts of it.  Model building blocks are represented by means of a 
rectangle with the name of the MBB in it. 
 

Active Model Building Blocks appear in black on the display.  When the user 
moves the mouse pointer on top of such a MBB, its colour will invert.  If the user 
clicks the mouse, the response will depend on the type of MBB.  If the MBB 
clicked is not a SuperMBB, then a dialog box will open.  This dialog box has the 
function of both receiving the data entered by the user and of communicating 
model results to the user.  If the MBB is a SuperMBB, then a more detailed 
diagram is shown in which each of the MBB’s will act as explained. 
 
Non-active MBB’s appear in grey in the diagrams.  They are copies (or Alias) of 
MBB’s that appear elsewhere in the diagram (usually in another View or at 
another hierarchical level).  Connections made with a Non-active MBB are in fact 
links with the Active version of the MBB. Further, the only function of the Non-
Active MBB is to increase the readability of the diagram. 

 
MBB’s that provide access to maps of the land side of the coast have a green contour, 
while MBB’s that provide access to maps of the sea side of the coast have a bleu contour. 
 
Connectors and Connections. 

Variables and parameters can be passed from one MBB to the other via 
Connections, or Pipes.  MBB’s will dispense variables or parameters with 
the rest of the model via Out-connectors, and will take-in information 
from other MBB’s via In-connectors. 

 
The actual exchange between MBB’s is possible when a Connection 
(or Pipe) is drawn between an Out-connector of the issuing block and 
the In-connector of the receiving block.  For each variable or 
parameter that is being exchanged, one connection is drawn (except if 
one of the MBB’s is a SuperMBB) in the diagram. 

 
All In-connectors are grouped on the In-side of the MBB and all the Out-connectors are 
grouped on the Out-side.  The In-side and Out-side of the MBB can never coincide.  
Apart from this restriction the user can freely decide which of the four sides of the MBB 
are In- and/or Out-side. 
 
In the diagrams In- and Out-Connectors will appear that are not connected to other 
MBB’s.  Rather they are represented by means of a special symbol in red.  They 
represent the connections that cross from one View into the other. 
 
Specifically in the Scenarios, Policy options and Impacts Views, connectors are used 
that refer to the fact that the MBB is connected to a larger diagram which is not 

 

 

 
 In-Connector 

 Out-Connector 

 Connector 
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completely represented in the respective View. 
 

Connector Description 
 Standard In-Connector bringing-in information from another MBB. 
 Standard Out-Connector issuing information available to another MBB. 
 In-Connector bringing-in information from a Scenario MBB. 
 In-Connector bringing-in information from a Policy options MBB. 
 Out-Connector issuing information to an Impacts MBB. 
 In-Connector bringing-in information from a MBB not shown in the

View. 
 Out-Connector issuing information to a MBB not shown in the View. 

 
Dialog boxes. 
Each MBB has a dialog box attached to it.  This dialog box is the vehicle that permits the 
interactive exchange of information between the user and the Model Building Block.  
The MBB will communicate the results (output) of its numerical operations to the user 
and it will accept the data entered (input) by the user that are required for the execution 
of the MBB.  It concerns data that are internal to the MBB and which it does not get from 
other MBB’s via its In-Connectors. 
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When a dialog box is opened, the user can open an information page containing more 
information about the MBB to which it is attached.  To this end, he simply has to push 
the F1-key while the dialog box is active.  Above is the documentation page linked to the 
MBB ‘Food Supply’. 
 
Typically the information is organised under a number of headings: 
 
Heading in the 
documentation page 

 
Description 

definition Describes briefly the function of the MBB; 
application Explains where in the model this MBB is used; 
mathematical formulation Contains the mathematical expression which is solved in 

the MBB 
out-connector(s) Names the different Output-variables calculated in this 

MBB (and which are available from the out-connectors of 
the MBB) 

internal parameter(s) Names the different parameters that are specific to the 
MBB and that need to be read-in via the dialog-box; 

in-connector(s) Names the different Input-variables that are needed in this 
MBB and that are entered into the MBB via its In-
conectors; 

reference(s) Contains reference material about the MBB 
 
The documentation pages are very usefull to obtain the details of the model.  Not only do 
they provide information about the different variables and parameters that appear in the 
dialog boxes (and are used in the MBB), but they also contain information about the 
mathematical expressions used, etc.  Moreover, MBB’s that get as an input data from 
other MBB’s will display the names of these variables in green and underlined.  If the 
user clicks this (hyper)text, then the documentation page of the corresponding MBB is 
opened.  Thus, the user can navigate through the whole model to uncover how it fits 
together. 
 
In the dialog boxes model results and model inputs are presented in Edit Fields.  The 
difference between input and output fields is indicated by the colour of the text in the 
edit field: green for state variables (to be entered as initial values and for the remainder 
output of the MBB); purple and blue for intermediate variables; black for variables or 
parameters copied from other MBB’s (output of the MBB); and finally red for internal 
parameters of the MBB (input for the MBB). 
 
Colour of text in the 
Edit Fields of  
MBB-dialog boxes 

 
Description 

RED Input. Parameter value (can be changed during the entire 
simulation) or State variable at the initial state. 

PURPLE Input. Variable value. If the edit field is clicked, a dialog will 
pop-up requesting input necessary for the calculation of the 
variable  

GREEN Input / Output. State variable which can be changed at the start 
of the simulation, and which display output for the remainder. 

BLUE Output. Variable value. (read-only) 
BLACK Output. Values copied from other MBB’s. (read-only) 
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A simple way of finding out whether a field will accept input or not is by simply moving 
the mouse over it.  If the field can be edited, the mouse pointer will change shape in 
function of the type of data that are to be entered.  If the mouse is clicked, the appropriate 
editor is opened.  In Annex A, the meaning of the different pointers is explained. 
 
One of three editors will open: 
 
A single value numerical editor. 
 

 
This editor allows the user to enter a single numerical value.  More 
precisely it will display a default setting –the result of the 
calibration of the model-- with the request to change it with a value 
within the range specified: 
 

Minimum ≤≤≤≤ value entered ≤≤≤≤ Maximum 
 
If values outside this range are entered, the user is warned. 

 
 
A table (of values) editor 
 
This editor allows the user to enter a series of numerical values.  More precisely it will 
request the user to change default values.  The values entered will all have to be inside a 
range specified: 
 

Minimum ≤≤≤≤ value entered ≤≤≤≤ Maximum 
 
If values outside this range are entered, the user is warned. 
 
A graph editor. 

 
 
This editor is used extensively 
in RAMCO --in both the Micro-
scale and Macro-scale model-- 
to change two-dimensional 
relations: time series, distance 
decay functions, etc.  It has two 
main parts: to the left a 
graphical representation of the 
two-dimensional relation, and 
to the right a list box with the 
co-ordinate pairs defining the 
relation.  The relation can be 
edited in each of the two parts. 
 
 
 

 
1. The easiest way to enter data is via direct manipulation of the graph.  Move the cursor 

to the abscissa position for which you want to enter a new (ordinate) value.  The 
pointer will change to a pen symbol indicating that it is positioned correctly on top of 
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a vertical grid line for which it will accept an ordinate value.  Move the pointer to the 
vertical position equal to the ordinate value which you want to enter.  Then click the 
left mouse button to enter the new ordinate of the point on the graph. 

2. The second manner of editing is useful if you have to enter exact numbers rather than 
trends or approximate numbers.  It consists in clicking in the list box the co-ordinate 
pair that you want to change.  Then a dialog box will open in which you can enter the 
new ordinate value.  The changes made in one part of the graph editor are 
immediately visible in the other part.  The number of values to be entered as well as 
the range is displayed. 

 
A Dialog editor. 
 
The dialog editor is opened to enter the data for a small sub-model required to calculate 
the value of an intermediate variable (printed in purple).  This editor is used in particular 
to edit data that are subject to stocahstic perturbations such as Precipitation available 
from the Scenario View. 

3.2. Starting the simulation. 

Once the Micro-scale dynamics and the Macro-scale dynamics windows have been 
opened, the program has read-in the default values for all the parameters as well as the 
initial values for all the state variables of the model.  The program is ready to run a 
simulation.   
 

Verify this by pushing the Step button from the Tool bar.  Once pushed, RAMCO will 
go through a number of essential phases (such as the initialisation and testing of its 
inputs) which are of no direct interest to the user before it will make 1 simulation step.  
This will take a while.  You will notice that the action is finished when the simulation 
time changes from 0-1 to 1-1 and the land-use map in the Micro-scale dynamics 
window is being updated.  To put things more correctly we should say that the model 
will make 12 monthly steps in the macro-level model and one year step in the micro-
level model. 

 
Undo the simulation step by pushing the Reset button from the Tool bar.  This action 
will reset all the state variables of the model to their initial value, but will not do so for 
the values of the parameters.  These are not influenced by Reset and remain 
unchanged.  Since we have not changed parameter values the latter is of no importance 
now, but it will be an important issue once you will be changing parameter settings 
while running and testing different Scenarios and Policy options with the system. 

 
The Micro-scale dynamics and Macro-scale dynamics windows can not be closed by the 
user (the Close-window-icon in the Title bar of both windows is greyed out).  The user 
can only minimize or maximize their size by clicking the respective icons in the Title bar.  
The results of the micro-scale models is always shown by means of the map in the Micro-
scale dynamics window.  You can personalize the Micro-scale map by means of the 
command in the View and Options menu.  It is possible to add overlay information to it, 
such as the road system and the boundaries of the administrative regions.  If the region 
boundaries are drawn, it is possible to pick-up information per region from the map by 
clicking the left mouse button in the region of your choice.  An Information window will 
show an overview of the land use within the region.  While the simulation is running, this 
overview is updated dynamically, thus permitting to get an impression of the changes 
affecting the region. 
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The output of the macro-scale models is not visible 
unless the user has opened the parts of the model that 
he wants to consult.  As an example we will see what 
the model has to offer in the Food Supply MBB.  
Move the mouse to the MBB named Food Supply 
(System Diagram View).  As soon as the mouse is 
inside the borders of the MBB, the colour of the MBB 
will invert.  Now click the left mouse button.  The 
following dialog box will open. 
 
Now have the simulation take one simulation step 
again (by pushing the Step button) while watching the 
values displayed in the box.  Notice that the values of 
the variables are updated 12 times as the 12 monthly 
simulation steps are taken.  Finally, the map in the 
Micro-scale dynamics window is updated. This 
demonstrates the fact that models developed with 
RAMCO have coupled micro- and macro-components 
running simultaneously. 
 

 
For variables preceded by a white check-box, such as 'Total employment' in the Human 
welfare MBB of the Impacts View, the model allows to make a time-graph.  All you need 
to do is to click in the check box and the graph will open.  As long as it is opened, it will 
be updated at each simulation time step.  To close it, you should click the Close-window-
icon in the title bar of the Graph window. 

3.3. Viewing model output 

The flexibility of RAMCO is also reflected in the manner in which output can be 
displayed and viewed.  Indeed, the user has a lot of freedom in selecting and organising 
the in- and output windows.  The version 2.0 of RAMCO has hundreds of windows 
containing information related to the model.  These windows are all accessible in 
accordance with the structure and the logic explained: Macro-scale dynamics model; 
Micro-scale dynamics model; Views; SuperMBB’s; MBB’s; dialog boxes; Graphs, and 
Maps.  A window or dialog will be opened by the user and will stay open untill it is 
minimized or closed by the user.  While the simulation is running all the windows that 
are opened are updated.  This has the great advantage of displaying information from 
linked MBB’s simultaneously and the user can see how changes occur in different parts 
of the model. 
 
However, the user should learn to manage output windows carefully and to close those 
windows he is not directly interested in.  If not, his screen will get overloaded with ‘left-
over’ information which he is not really using, but also, every opened window is updated 
by RAMCO.  Updating information takes execution time and memory space.  Hence the 
program might slow down considerably. Certainly when maps are being used, it is 
imperative to close as much as possible the maps that are not of immediate interest to the 
user. 
 
Moving the mouse with the left mouse-button clicked-down in the Title bar of a window, 
will permit to move the window around.  It is good practice to organise the screen in such 
a way that the dialogs are all grouped on one side and the map(s) on the other side of the 
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screen.  This will permit to see simultaneously the macro- and microscopic effects of the 
simulation. 

3.4. Saving simulation results. 

Working with Decision Support Systems is to a large extent an iterative process: the 
decision maker is exploring different combinations of policy alternatives to learn 
interactively which interventions are likely to satisfy the policy criteria.  These 
explorative exercises require a capacity to store simulation results in an efficient manner. 
 

The Save simulation 
command from RAMCO’s 
File menu allows the user to 
store simulation results in 
more or less sophisticated 
manners.  More in 
particular it allows the user 
to efficiently manage the 
different kinds of files that 
constitute a single 
simulation.  Indeed, a 
simulation requires not just 
one, but 10 to 20 data files, 
hence, saving a large 
number of simulation runs 
will require a large storage 
space on your hard disk(s). 
 

When the user selects Save Simulation from the File menu, the Save dialog box will 
open, requesting the user to enter the name of the file. If the name of the current 
simulation file is entered, then it will be overwritten, and the original values will be lost.  
Overwriting files can be avoided by simply choosing another file name than the current 
one.  Once the name of the file is entered and the Save button has been pressed, the 
system will display the Simulation file ... .SIM dialog box. 
 

If you are a relatively new 
user of RamCo, simply 
press the OK button to 
complete the action of 
saving the simulation and 
skip the remainder of this 
section.  If however, you 
are more experienced with 
the system this dialog box 
will help you to change the 
composition of your 
simulation file before 
saving it. The dialog box 
shows an overview of all 
the file types --and their 
respective names-- that are 
used in a simulation. 

 



 

RamCo User Guide - Version 2.0 June 1999 Page 37 

In the dialog box, the files are preceded by a check box.  Files preceded by a crossed 
check box will be saved with the name mentioned to their right.  The program keeps 
track of the actions that the user has performed during a session and knows what files are 
affected by it.  These files are shown with their check-box crossed, and that is why the 
program suggests to save them. 
 
If however you do not want a new copy  --for example because the corrections you made 
are not important to you-- then you simple cross out the check box.  Although this 
procedure might seem cumbersome at first, it will become a great help to you once you 
are more familiar with the system. RAMCO saves its output in exactly the same format as 
its inputs.  Hence, you can always use saved simulations as the input for a new run.  
Keep in mind however that the simulation clock will be set back to 0-1 when you 
continue a simulation in this way. 
 
‘Save simulation’ will only save final results of the model (current values of state 
variables and parameters).  It will not store intermediate results.  To save these, you 
should make use of the ‘Log ...’ and the ‘Link to Excel’ commands from the Options 
menu. 
 
‘Log ...’ will save Micro-scale simulation results.  More in particular it will store maps in 
a .LOG file.  When the ‘Log ...’ command is selected, the user will have to enter the 
interval for which he wants to store maps. 
 
The ‘Link to Excel’ command will permit to send simulation data to a Microsoft Excel 
Workbook.  More in particular the values of the policy impact indicators --and accessible 
from the Impacts View-- can be send to Excel.  It is possible to save this Workbook 
(using the Excel commands) and thus store the data for further analysis. 

3.5. Printing simulation results 

Printing simulation results can be done in different manners.  RAMCO supports very 
directly the printing of maps.  To this end, you can invoke from the File menu the 
commands Page Setup, Print preview and Print. First select Page Setup to decide on the 
scale of the map, expressed as the number of cells which you want to print per unit of 
measurement (for example 5 cells (5 * 400 m = 2000 m) per cm for a map of SW 
Sulawesi at a scale of 1/200.000), then select Print Preview to get an idea on how the 
printed maps will look like, and finally push the Print button in the Print Preview window 
or from the Tool bar to print the maps. 
 
Results from the Macro-level model can be printed by selecting ‘Link to Excel’ from the 
Options menu and use the Excel print functions to get the results on paper.  If you want 
from a particular MBB, then click it to open its dialog box.  Once the dialog box is open, 
key-in Alt + Prt Sc.  This will put the dialog box on the Windows Clipboard.  Now open 
your Paintbrush, Paint or Word Processing package and select Paste from its Edit menu.  
Once the dialog window has been pasted, Print the dialog by using the print facilities of 
the receiving package.  This procedure works not only for dialogs, but for all RAMCO’s 
windows.  It is handy to print among other the 3 D representation of the study area.
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4. The RAMCO Menu System 

This Chapter explains the different commands that are available in RAMCO’s Menu 
System.  The Menus will be treated as they appear in the Menu bar from left to right. 

4.1. The File Menu 

 
 
 
 
 
Use the File menu to create a new simulation file or open an existing 
one, save and print files, and to exit RAMCO. 
 
RAMCO saves simulation files with a .SIM extension attached to the 
filename. 
 
 
 
 
 

4.1.1. New simulation Command 

Use the ‘New simulation’ command to create a new simulation file. 
 
This option is greyed out and not available in this version of RAMCO, because it comes 
with the specially tailored model for SW Sulawesi. 

4.1.2. Open simulation Command 

Use the ‘Open command’ to open a simulation file stored on a disk.  You can open only 
one simulation file at the time.  Use the Windows menu or the mouse to switch among 
the different windows opened by the simulation. 
 
When you select ‘Open simulation’, the Open dialog box appears.  If the name of the file 
of your choice is not visible in the list box, use the scroll bar to move through the list of 
filenames in the directory or disk you are working in.  If the file you want to open is not 
in the current directory or on the current disk, use the scroll list or browse symbols in the 
section named ‘Look in:’ to change directories, drives or network site. 
 
Double-click the name of the file you want to open.  You can also type the name and path 
of the file in the Filename box.  Choose open after you have typed the name of the file. 
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4.1.3. Save simulation as… Command 

Use the ‘Save simulation as …’ command to save a simulation to a disk.  When you save 
a simulation, a Save As dialog box.  This box allows you to specify the name of the file 
and the location where you want to store it.  When you click the Save button, RAMCO 
displays the Simulation file … dialog box which shows an overview of the different files 
that constitute the simulation your are storing.  The file names that are preceded by a 
crossed check box, have been changed by the user during the session and will be saved if 
the OK button is pushed.  If you want to save them under a different name, click on the 
name and enter the new name of your choice.  Be careful not to change the extension of 
the files. 

4.1.4. Import file... Command 

Use the ‘Import file…’ command to import a file from disk into the simulation.  
Importing and exporting files is possible for all maps that can be edited in the system 
(Land Use, Suitability, Network, Regions map, …).  The type of map has to be selected 
from the menu and has to be in the active window before the ‘Import file...’ command 
will be active.  When active, ‘Import file...’ will open a Open dialog box displaying all 
the files in the working directory with the correct extension.  If you change the type of 
file to import in the appropriate scroll list, you will be able to import IDRISI files with 
.IMG extension. 

4.1.5. Export file... Command 

Use the ‘Export file...’ command to export a file from the simulation to disk.  Exporting 
and importing files is possible for all maps that can be edited in the system (Land Use, 
Suitability, Network, Regions map, …).  The type of map has to be selected from the 
menu and has to be in the active window before the ‘Import file...’ command will be 
active.  When active, ‘Export file...’ will open a Save dialog box displaying all the files 
in the working directory with the correct extension.  If the user changes the type of file to 
export in the appropriate scroll list, he will be able to export files to IDRISI with the 
.IMG extension. 

4.1.6. Page Setup Command 

Use the Page Setup command to decide on the size and scale at which you want RAMCO 
to print the simulation results of the Micro-level model. 

4.1.7. Print Command 

Use the Print command to print the maps generated by the Micro-level model. 

4.1.8. Print Preview Command 

Use the Print Preview command to get a preview on the screen of the printed document. 

4.1.9. Print Setup Command 

Use the Print Setup command to arrange the setup of your printer, so that simulation 
results will be correctly printed by RAMCO. 
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4.1.10. List of Recent File (1, 2, 3, 4) 

RAMCO keeps track of the 4 most recent files opened by the program. It will display 
those in the File menu.  If you select one of the 4 files, it will be opened. 

4.1.11. Exit Command 

Use the Exit command to quit RAMCO and return to Windows. 
 
If you have made changes to simulation files since the last time that you saved the 
simulation, a dialog box appears asking whether you want to save the simulation file 
before exiting RAMCO. 
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4.2. Edit Menu 

 
Use the commands on the Edit menu to edit the maps of the micro-scale models.  The 
first three commands on the Edit menu are standard, but for each type of map one or 
more commands will be added to permit specific edit operations.  These will be 
explained in more detail in section 3.4 Maps menu. 

 
Be careful, RamCo is not equipped with a so-called Undo command.  Hence, all 
corrections made are definite! 

4.2.1. Pen Command 

Use the Pen command to pick a value from the legend of the map (by clicking the radio 
button next to a reading) and entering it in the map by clicking the cell of your choice. 
 
This command will change the pointer into a pen.  It is identical to selecting the Pen icon 
from the Tool bar. 

4.2.2. Fill Command 

Use the Fill command to pick a value from the legend of the map (by clicking the radio 
button next to a reading) and entering it in larger, contiguous areas of the map.  The Fill 
command will change the values of all the adjacent cells that have the same colour as the 
one that is clicked.  All these adjacent cells will get the value that is selected from the 
legend. 
 
This command will change the pointer into a bucket.  It is identical to selecting the 
Bucket icon from the Tool bar. 

4.2.3. Precision Command 

Use the Precision command to enter detailed information on a cell by cell basis.  When a 
cell is clicked, a dialog box will open which allows you to enter the exact value. 
 
This command is identical to selecting the Ruler icon from the Tool bar. 
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4.3. View Menu 

 
Use the View menu to change the manner in which the different maps of the Micro-
scale model are displayed.  The first three commands on the View menu are standard, 
but for each type of map one or more commands will be added to specify views. 
These will be explained in more detail in section 3.4 Maps menu. 

4.3.1. Go to... Command 

Use the ‘Go to...’ command to move the cursor to a specific location on the map.  
Selecting this command from the View menu will open a dialog box requesting to enter 
the co-ordinates of the desired location. 

4.3.2. Zoom in Command 

Use the ‘Zoom in’ command to increase the size of the map on your screen by a factor 2. 
This command is identical to selecting the Zoom-in icon from the Tool bar. 

4.3.3. Zoom out Command 

Use the ‘Zoom out’ command to reduce the size of the map on your screen by a factor 2. 
This command is identical to selecting the Zoom-out icon from the Tool bar. 
 

When the Micro-scale dynamics window is the active window, the View menu is 
completed with four additional commands: Show regions, Show network, Show 
elevation and 3D settings.  These commands allow the user to draw overlay 
information on top of the Micro-scale simulation window. 
 

4.3.4. Show regions Command 

Use the ‘Show regions’ command to draw (or remove) the boundaries of the regions, as 
defined in the Regions map, on top of the land uses in the Micro-scale dynamics window. 

4.3.5. Show network Command 

Use the ‘Show network’ command to draw (or remove) the network, as defined in the 
network map, on top of the land uses in the Micro-scale dynamics window. 

4.3.6. Show elevation Command 

Use the ‘Show elevation’ command to change the flat land use map of the Micro-scale 
dynamics window into a 3D representation.  The relief of this representation is as defined 
in the elevation map. 

4.3.7. 3D settings Command 
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Use the ‘3D settings’ command to change the manner in which the 3D diagram is 
represented.  This command is only active when the land use map of the Micro-
scale dynamics window is shown as a 3D diagram. When you select the ‘3D 
settings’ command you will get a dialog box that allows you to specify the angle 
of rotation, the perspective and the vertical exaggeration of the diagram. 
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4.4. Maps Menu 

 
Use the Maps menu to select the different maps and their respective editor 
that are being used in the micro scale model.  The Landuse, Elevation, 
Network, Suitability maps, Marine park, Coral maps and Wave height will 
each open in their own mapping window and with their own editors.  The 
Regions and USLE maps are input to RamCo models, but can not be edited.  
The Potential maps and Suspended sediment maps are model outputs and 
can not be edited. 
 
The editors will become active as soon as the grid will be shown on top 
of the maps.  In order to see the grid, and to invoke the editors, it might 
be necessary to Zoom-in and enlarge the map ! 
 
 

4.4.1. Landuse Command 

 
Use the ‘Landuse’ command to select the land use map and its editor in the Landuse 
window.  With the Landuse editor it is possible to change the land use map as cells can 
be given a different landuse. 
 

When the landuse map is selected, the Edit menu will get one additional 
command named ‘Change landuse’.  This command allows you to change the 
name and colour of the land use functions.  When it is selected a Change Land 
use dialog box will open. 

4.4.2. Elevation Command 

Use the ‘Elevation’ command to select the elevation map and its editor in the Elevation 
window.  With the Elevation editor it is possible to change the elevation map as cells can 
be given a different height. 
 

When the land use map is selected, the View menu will get one additional command 
named ‘Legend…’.  This command allows you to change the classification that is 
used to display the elevation data on the map.  When it is selected a Legend dialog 
box will open.  It will request you to enter the maximum of the highest class, the 
interval of values above sea-level, the minimum of the lowest class, and the interval 
of classes below sea-level.  These data are used to create classes of equal length. 

4.4.3. Network Command 

Use the ‘Network’ command to select the network map and its editor in the Network 
window.  With the Network editor it is possible to change the network as network links 
and network nodes can be added to the network or removed from it. 
 

When the network map is selected, the Edit menu will get two additional commands named: 
‘Accessibility parameters’ and ‘Compute accessibility’. 
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When ‘Accessibility parameters’ is selected, an Accessibility parameters 
dialog box will open which will request the user to enter a number per 
land use function, reflecting the sensitivity of the function to good access 
to the network. 
 

When ‘Compute accessibility’ is selected, new accessibility values per 
cell and per land use function are calculated.  ‘Compute accessibility’ 
should be invoked every time the accessibility parameters have been 
changed, or if the network has been changed. 
 
When the network map is selected, the View menu will get a number 
of additional commands.  These permit you to change the background 
colour of the network map.  Backgrounds will either be blank (White 
background), the actual land use (Land use, the standard option), or 
the accessibility for one of the land uses. 
 

4.4.4. Suitability maps Command 

Use the ‘Suitability maps’ command to select one of the suitability maps and its 
editor in the Suitability window.  With the Suitability editor it is possible to 
change a suitability map as cells can be given a different suitability value. 
 
 
 
 
 
 
When a suitability map is selected, the View menu will get one additional 
command named Show features.  This command allows to display the cells 
occupied by a land use feature by means of a special symbol.  These cells are 
excluded for the allocation of (dynamic) land use functions. 

4.4.5. Marine park 

Use the ‘Marine park’ command to select the Marine park map and its editor in the 
Marine park window.  With the Marine park editor it is possible to select a site for the 
Marine park or to change the position of the Marine park. 
 
Attention, the area represented in the Marine park map is bigger than the area in 
the other maps.  This is to allow you to install a Marine park outside the modelled 
coastal area. 
 

When the Marine park map is selected, the Edit menu will get one additional 
command named ‘Change landuse’.  This command allows you to change the 
name and colour with which the Marine park is shown on the map.  When it is 
selected a Change Land use dialog box will open. 

4.4.6. Coral maps 
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Use the ‘Coral maps’ command to select one of the Coral maps and its editor in 
the Coral map window.  The following 3 Coral maps can be edited: Coral 
surface, Live coral cover, and Coral species. 
 

When one of the Coral maps is selected, the View menu will get one additional 
command named ‘Legend…’.  This command allows you to change the classification 
that is used to display the coral data on the map.  When it is selected a Legend dialog 
box will open.  It will request you to enter the maximum of the highest class, the 
interval of the classes containing positive numbers, the minimum of the lowest class, 
and the interval of classes containing negative numbers.  These data are used to create 
classes of equal length.  For the 3 Coral maps, the values represented are always 
positive, hence, there is no need to specify intevals and minimum values for negative 
numbers. 

4.4.7. Wave height 

Use the ‘Wave height’ command to select the Wave height map and its editor in the 
Wave height window.  With the Wave height editor it is possible to change the Wave 
height map as cells can be given a different Wave height value. 
 

When the Wave height map is selected, the View menu will get one additional 
command named ‘Legend…’.  This command allows you to change the classification 
that is used to display the wave height data on the map.  When it is selected a Legend 
dialog box will open.  It will request you to enter the maximum of the highest class, 
the interval of the classes containing positive numbers, the minimum of the lowest 
class, and the interval of classes containing negative numbers.  These data are used to 
create classes of equal length.  For the Wave height map, the values represented are 
always positive, hence, there is no need to specify intevals and minimum values for 
negative numbers. 

4.4.8. Regions Command 

Use the ‘Regions’ command to view the Regions map in the Regions window.  The 
Regions map shows the different geographical entities for which the model will generate 
regional sums.  The Regions map is fixed for the model and can not be changed by the 
user. 
 

When the Regions map is selected, the Edit menu will get one additional 
command named ‘Component...’ .  When this command is clicked, a dialog box 
will open requesting the user to enter a weight for each land use.  These weights 
are multiplied with the total number of cells of that type and presented in the 
information window which can be opened by clicking in a region.  Thus, the 
number of cells can be translated in another measure (i.e. if the component is the 
surface of a cell in ha, the totals generated will be the area in ha taken in per land 
use function.) 

4.4.9. USLE maps Command 

Use the USLE maps command to view the spatial parameters (used in the 
USLE MBB of the Macro-scale model) in the USLE map window.  The 
following 3 USLE parameters can be viewed: Rainfall (R-factor), Erosion 
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sensitivity (K-factor) and Slopes.  The USLE maps are fixed in the model and can not be changed by 
the user. 

4.4.10. Potential Command 

Use the ‘Potential’ command to view one of the Potential maps in the Potential 
window.  A Potential map displays the transition potential of a cell to change to 
the land use specified.  The transition potentials are used to decide which land 
use will be allocated to each cell in the next simulation step. 
 
 
 
When a potential map is selected, the View menu will get one additional 
command named ‘Show function’.  This command allows you to display the cells 
taken in by the land use function for which the potential is displayed on the map.  
It allows you to get an idea to what extent the land use function is indeed present 
in cells with a high transition potential for the specific function. 

4.4.11. Suspended sediment Command 

Use the ‘Suspended sediment’ command to view the suspended sediment map in the 
Suspended sediment window. 
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4.5. Rules Menu 

 
 
 
 
 
Use the Rules Menu to view or specify the spatial interaction forces that typify 
each possible pair of land uses. 
 
 
 
 
 
 

4.5.1. (land use) Command 

Select from the menu the land use function (LU1) for which you would like to enter, edit 
or view its interaction with another land use (LU2).  Select this other land (LU2) use by 
pointing at it in the cascading menu that will open and by clicking it.  As a result the 
Graph editor will open.  From its title bar you will read what interaction is to be entered:  
‘Effect of (land use LU2) on (land use LU1)’. 

4.5.2. Overview Command 

Use the Overview command to get an overview of the complete set of interaction rules 
defined in the model.  The colours representing the different land uses are the same as 
those in the Micro-scale window. 
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4.6. Simulation Menu 

 
 
 
 
Use the Simulation menu to control the simulation. 
 
 
 
 
 
 

4.6.1. Init Command 

Use the ‘Init’ command to initialise the simulation.  After the model has been initialised 
all the variables are displaying the correct initial condition (values) of the model.  If the 
‘Step’ or ‘Run’ command is selected the simulation will be automatically initialised if 
this has not been done manually. 

4.6.2. Step Command 

Use the ‘Step’ command to advance the simulation with one step.  This command is 
identical to clicking the Step button from the Tool bar.  The size of the step is set by the 
‘Steps...’ command in the same Simulation menu.  Once the model has been initialised 
all the windows display the correct initial condition (values) of the model.  If the ‘Step’ 
or ‘Run’ command is selected the simulation will be automatically initialised if this has 
not been done manually. 

4.6.3. Run Command 

Use the ‘Run’ command to advance the simulation till the next pause tab has been 
reached.  This command is identical to clicking the Run button from the Tool bar.  Once 
the simulation is running, it can be halted by the user by selecting the ‘Stop’ command 
from the Simulation Menu or by pressing the Stop button from the Tool bar.  The default 
simulation run will take 300 months or 25 years.  The Macro-model is updated on a 
monthly basis, and the Micro-model is updated every twelfth month (every year). 

4.6.4. Stop Command 

Use the ‘Stop’ command to interrupt the simulation.  This command is identical to 
clicking the Stop button from the Tool bar.  Once interrupted, the simulation will halt till 
the user selects the ‘Step’ or ‘Run’ command from the Simulation Menu or till the Step 
or Run button from the Tool bar is pushed. 

4.6.5. Reset Command 

Use the ‘Reset’ command to switch the clock of the simulation back to 0-1 (month 1 of 
year 0).  This command is identical to clicking the Reset button from the Tool bar.  
Selecting Reset will set the simulation clock equal to 0-1, the state variables and maps 
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will be set equal to their initial values (hence the changes made during the simulation are 
lost), and the parameters keep their actual value. 

4.6.6. Pauses ... Command 

Use the ‘Pauses...’ command to set the pause tabs of the simulation.  When Pauses ... is 
selected, a dialog box will open requesting the user to enter the time interval (in years) 
for which he wants the simulation to halt. 

4.6.7.  Random ... Command 

Use the ‘Random ...’ command to run the simulation in stochastic mode.  When Random 
... is selected, a dialog box will open requesting the user to set a value for the alpha 
parameter as well as the seed value for the random generator. 

4.6.8. Steps ... Command 

Use the ‘Steps...’ command to set the step size.  When Steps ... is selected, a dialog box 
will open requesting the user to select 1 month or 1 year (12 months) as the step size.  
Every time the ‘Step’ command from the Simulation menu is selected or the Step button 
from the Tool bar is pushed, the simulation is advanced by this amount of months (1 
iteration = 1 month). 
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4.7. Options Menu 

 
 
 
 
Use the Options Menu to personalise your workspace. 
 
 
 
 
 

4.7.1. Grid ... Command 

Use the ‘Grid ...’ command to draw a (major) grid on the maps.  When Grid is selected 
from the Options menu, a dialog box will open.  The user is requested to switch on or off 
the Major grid check box.  Next he is to enter the size of the grid expressed in number of 
cells.  Finally he can offset the origin of the grid by a certain amount of cells (for 
example in order to fit a reference system of some sort). 

4.7.2. Font ... Command 

Use the ‘Font ...’ command to change the font, font style and size of the character set 
used to print the legends of maps and the informative windows. 

4.7.3. Link to Excel … Command 

Use the ‘Link to Excel…’ command to link RAMCO with the Microsoft Excel Workbook 
IMPACT.XLS.  This link is a DDE (Dynamic Data Exchange) link.  Via this link 
RAMCO is sending model output to the Workbook while the simulation is advancing.  
Note that in order to establish a successful link, it is required that Excel is installed on 
your machine.  If RAMCO can not find Excel, the menu option will be greyed out.  The 
Workbook IMPACT.XLS is available to the user once the simulation is finished.  It can 
be used for further analysis of the simulation data. 

4.7.4. Log ... Command 

Use the ‘Log ...’ command to store the land use maps produced by the micro-level model 
in a .LOG file.  When Log ... is selected, a dialog box will open requesting the user to 
enter the name of the .LOG file and the interval for which simulation results are to be 
written to the file. 
 
.LOG files can be analysed by means of the ANALYSE utility program (see section 5). 

4.7.5. User Command 

Use the User command to select one of the three user types supported by RAMCO: Policy 
maker, Analyst and Modeller. 
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User type ‘Policy Maker’ can only change parameter values in the Policy options, 
Scenarios and Impacts Views.  This user type can not change the minimum and 
maximum ranges of parameters or variables. 
User type ‘Analyst’ can change parameter and variable values in all the Views of 
RAMCO.  In future versions of RAMCO this user type will be able to change 
existing models or build new models by means of MBB’s available from the MBB 
libraries. 

User type ‘Modeller’ is not supported in this version of RAMCO.  In future versions this 
user type will be able to develop new MBB’s and add those to the MBB libraries. 

4.7.6. Tool bar Command 

Use the ‘Tool bar’ command to view or hide the Tool bar in the Applications window. 

4.7.7. Status bar Command 

Use the ‘Status bar’ command to view or hide the Status bar in the Applications window. 
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4.8. Window Menu 

 
 
 
Use the Window menu to arrange the contents of the screen and to 
activate one of the opened windows. 
 
 
 
 

4.8.1. Cascade Command 

Use the ‘Cascade’ command to arrange multiple opened windows in an overlapped 
fashion so that the Title bar of each window is visible. 

4.8.2. Tile Horizontal Command 

Use the ‘Tile Horizontal’ command to vertically arrange multiple opened windows in a 
non-overlapped fashion so that all windows are visible. 

4.8.3. Tile Vertical Command 

Use the ‘Tile Vertical’ command to arrange multiple opened windows side by side in a 
non-overlapped fashion so that all windows are visible. 

4.8.4. Arrange Icons Command 

Use the ‘Arrange Icons’ command to arrange the icons for minimized windows at the 
bottom of the screen.  If RAMCO’S windows are positioned at the bottom of the screen, 
they may hide some or all of the icons. 

4.8.5. Close windows Command 

Use the ‘Close windows’ command to close all the opened windows except for the ones 
that can not be closed (in particular the Micro-scale dynamics and Macro-scale dynamics 
windows). 

4.8.6. List of Windows (1, 2, 3, 4, ...) 

At the bottom of the Windows menu a list of open windows is presented.  A check mark 
appears in front of the document name of the active window.  Choose a name from this 
list to make the window active. 
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4.9. Help Menu 

 
Use the Help menu to select the type of Help you want RAMCO to display on the 
screen.  The different commands in this menu will permit to look up information 
about RAMCO, its commands, options, and tools. 
 

4.9.1. Index Command 

Use the Index command to get the opening screen of the Help file of RAMCO.  From the 
opening screen, you can jump to step-by-step instructions for using RAMCO.  Double 
click the topic you want help on.  A Help screen will appear.  Once you open Help, you 
can click the contents button whenever you want to return to the opening screen. 
 
In this version of RAMCO the on-line Help is very incomplete, 

4.9.2. Using Help Command 

Use the Using Help command for getting general instructions on how to use the 
Windows Help System. 

4.9.3. About ... Command 

Use the About ... command to get the copyright notice and version number of the 
RAMCO application which you are using.  The latter is important if you need assistance 
with the software from the developers or when you request an update of the software. 



 

RamCo User Guide - Version 2.0 June 1999 Page 56 

 



 

RamCo User Guide - Version 2.0 June 1999 Page 57 

5. ANALYSE  

The program ANALYSE, which is also on the RAMCO Demo diskettes, can be used to 
analyse log files created with RAMCO.  To run ANALYSE click on the Start button in 
the Windows Task bar point at the Programs folder and move to the RAMCO sub-folder.  
Then finally select the ANALYSE icon. 

5.1. Basic concepts and features 

As explained in scetion 3.7, RAMCO allows you to store map output from the micro 
model in the so-called log files.  Hence, a log file consists of a sequence of maps 
generated by a simulation.  The name of a map in such log file consists of the 
concatenation of the name of the log file and the iteration number.  With ANALYSE you 
are able to compare any two maps within the log file, and see the differences graphically 
as well as in numbers.  Also the comparison of maps from different log files is possible. 
 

 
 

The ANALYSE window has a menu bar with the menus: File, Options, and Help. 
 
The File menu contains commands to open and close log files, to print, and exit. 
Select Open to open a log file. If there is already a log file open, the program will append 
(up to a maximum of 42 maps) the maps of the newly opened file to the current list.  
Thus you will have the possibility of comparing maps from different simulation runs (and 
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log files).  Select Close to close all the log files opened.  Select Print to send the 
contents of the ANALYSE window to the default printer using the default printer setup 
of your Windows environment.  Select Exit to quit the ANALYSE program. 
 
The Options menu gives you the possibility to overlay a grid on the map (select Show 
grid/Hide grid), to represent each cell by a circle instead of a square (select 
Circle/Square), and to hide or show the legend (select Hide legend/Show legend). 
The Help menu only contains an About option. 
 
Just underneath the menu bar there is a toolbar. It contains three list boxes and four 
picture buttons. 

• Pushing the first button  will display the map selected in the first (left) list box 

• Pushing the second button  will display the map selected in the second (middle) 
list box. 

• Pushing the third button  will display differences between the two maps selected 
in the first (left) and the second (middle) list box. Differences are displayed for the 
land-use selected in the third (right) list box. The comparisons are made on a cell by 
cell basis. 

 

 
 

• Pushing the fourth button  will display the differences between the two maps 
selected in the first and the second list box by means of a matrix-like numerical 
overview.  Next to this matrix representation, also the Kappa statistic is calculated 
and represented.  The Kappa statistic is a measure of the resemblance of both maps 
compared, globally or per land-use.  The resemblance is expressed by means of a 
figure in the range [0-1]. 
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6. Policy exercises with RAMCO 

Now that the general functionality of RAMCO has been covered, this chapter will briefly 
describe how to use RAMCO for Decision and Policy support in SW Sulawesi.  We will 
treat three exercises that are getting progressively more complex and require a better 
understanding of the SW Sulawesi model and RAMCO. 

6.1. Introduction 

Policy making and more generally Decision making is a stepwise process.  In order to 
come to a decision, the steps are run through sequentially in one or more iteration.  
Depending on the author or the literature that is consulted, the process is subdivided in 
more or less phases (or steps) and different names are given to each phase.  Some 
agreement seems to exist on the following three major phases, and their contents: 
• the identification phase, the purpose of this phase is to better discern the real problem 

which requires a decision to be taken.  This is an analytical phase during which the 
real origin of a problem is the topic of research, before suggestions to solve the 
problem are made. 

• the development phase, this is the phase during which a more or less large number of 
alternative solutions for the problems are developed. 

• the selection phase, is finally the phase during which the least unfavorable solution 
amoung all alternative solutions is searched for and selected. 

 
Although we have mentioned the three phases in a sequential order, it should be stated 
clearly that decision making is very often a cyclical process, during which some if not all 
of the phases are run through a number of times.  The purpose of these cycles is clearly: 
(1) to get an in depth understanding of the real problems; (2) to generate more and better 
solutions, and (3) to decide upon an intervention or a combination of interventions that 
will solve the problem, at least in part. 
 
Full fletched Decision Support Systems (DSS) will support the decision maker in each of 
the three phases mentioned.  However many so-called Decision Support Systems will 
focuss on one or two of the phases only.  For example quantitative models are used to 
generate alternative solutions during the development phase, while multi-criteria analysis 
is used to select amoung alternative solutions in the selection phase. 
 
This version of RAMCO provides support for both the first and the second phase.  
RAMCO will help the user to get a better understanding of the origin of problems as they 
exist in SW Sulawesi or as they might pop-up in a more or less distant future and it will 
support the user in the design and evaluation of alternative solution to cope with these 
problems.  The selection phase is less well supported bij RAMCO, since there is less 
functionality built-in to compare and rank alternative solutions, other than what is 
available in ANALYSE, Microsoft Excel or IDRISI. 
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In the three exercises we will study the effects of external factors and policy 
interventions.  The exercises have been kept rather simple.  Their purpose is mainly to 
make you acquainted with RAMCO to the point that you will be able to run your own 
exercises.  First we will show how to study the effects of external factors.  Next we will 
see how interventions of the type ‘policy interventions’ can be tested with the system. 
 
If you intend to use RAMCO for planning or policy making, you should remember that 
you are working with a model and that this particular model is a strong simplification of 
reality.  More, RAMCO is an instrument intended for scientific analysis, hence, you have 
full access to nearly all of its parameter and variables.  Whenever you change parameters 
or variables beyond their validity interval, the model might generate results that are 
merely nonsense.  In conclusion, use the model in a responsible manner and with 
particular care ! 
 
All the exercises in this chapter will be done with the simulation files named 
Sulawesi.SIM and Deforest.SIM.  In the previous chapters we have explained how to 
Start RAMCO, how to Open a simulation and how to Run, Reset and Exit a simulation 
exercise.  We assume that you know this at this point.  Begin each of the exercises 
described underneath by starting RAMCO and opening the simulation file 
SULAWESI.SIM. 

6.2. Exercise a: introducing scenarios 

The effectiveness of coastal zone management can be strongly influenced by physical 
and social factors external to the coastal zone system.  They are usually beyond the 
control of the coastal zone manager or decision maker.  His intervention is limited to the 
early detection of possible dangers brought about by such factors and the design and 
implementation of counter measures.  In the model for South-West Sulawesi three 
external factors are included in the form of scenario variables: (1) the external markets 
and prices of fish, shrimp, rice, and other agricultural products, (2) the average 
precipitation, and (3) the demographic growth.  In example, the user may study the 
consequences of high or low population growth rates for the coastal zone system and see 
how these affect the results of his selected policy options. 
 
Aim:  The first exercise aims at analysing the effect of weak versus strong population 
growth in the sustainability of the coastal zone system.  More in particular we will 
analyse the effect of population growth on BOD production. 
 
Screen arrangement:  In this exercise we want to try out population growth scenarios 
and evaluate the impacts thereof on the coastal zone.  More in particular we will analyse 
the effects on the BOD production in the coastal zone.  We will arrange the screen layout 
in a manner to have all the in- and outputs of the model displayed which are of direct 
interest to us.  Thus we will be able to see how variables change while the simulation is 
running.  First, on the Macro scale dynamics window, select the Scenario View and click 
the ‘Population growth’ MBB.  Activate the Population growth dialog box and drag it to 
the top right side of the application window.  Next, select the Impacts View and click the 
‘Ecosystem vitality’ MBB.  Now drag the Ecosystem vitality dialog box to the right side 
of the Application window to position it just underneath the Population growth dialog 
box.  Next click the check box left of the text Total BOD load.  As a result the graph 
window will open; again place it on the right side of the Application window.  Finally 
click the minimize button of the Macro-scale dynamics window. 
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It is good practice to manage your windows very carefully.  This will keep you from 
being distracted and will help you to focus on the problem studied.  Keep only the 
windows opened that are of direct interest to you.  Windows and dialogs that are not 
visible are updated in the background, hence, you can always open them later if you 
would want to consult them. 
 
As a result of the above actions, your Application window should look more or less like 
this: 
 

 
What-if? run:  We will compare two scenarios: the first one with a population growth of 
1%, the second with a population growth of 4%. 
• Click in the Population growth dialog box and move your cursor to the Population 
growth rate edit field.  Notice how the cursor changes once you position it on top of the 
edit field.  Click to edit the default value, and enter 1 (for a growth of 1% yearly during 
the 25 years of the simulation) in the Edit value dialog box, and then click OK.  We are 
now ready to run the simulation. 

 
A Typical simulation run takes 25 years.  This period can be 
shortened by means of the ‘Pauses...’ command from the simulation 
menu.  For the purpose of this exercise we will run the simulation 
for 10 years.  Hence, enter 10.  Now click the Run button in the 
Tool bar.  
 
 

RAMCO will read from file all the additional information needed to run your simulation, 
it will initialise the simulation, and will then start stepping through the simulation period.  
Notice how the clock starts ticking away the months and how the numbers in the dialog 
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boxes on your screen are changing. Write down the total amount of BOD produced as 
soon as the simulation comes to a halt (after 10 years).  The figure we are interested in is 
to be found in the column named Value at date 
• What is the unit used for BOD you wonder?  BOD (Biological Oxygen Demand) is a 
general indicator for organic pollution of surface waters.  You will see what its units are 
if you activate the Ecosystem vitality dialog box and then push the F1-key to invoke the 
Documentation page linked to the Ecosystem vitality MBB.  From this page you will 
learn that BOD is expressed in ton/day in this model. 
• Now check what part of the BOD is urban.  To that end you need to dig deeper into the 
model.  From the Window menu select Macro-scale dynamics window to bring it back to 
the foreground. Select on that window the System diagram View.  Click the ‘Pollution’ 
SuperMBB.  As a result the diagram of this part of the model pops-up.  Select the ‘Urban 
BOD production’ MBB and read the details about the BOD production from the dialog 
box.  Again make a note of the amount read from the dialog box. 
• Next we will do the same exercise with a high population growth rate.  Push the Reset 
button from the Tool bar to return the simulation to its initial state.  All you need to do is 
to enter a population growth rate of 4% in the Population growth dialog box and run the 
simulation again.  Take note of the total population, the total BOD production and the 
Urban BOD production.  What are your conclusions from this exercise ? 
• Finally reset the simulation one more time and enter a value for the population growth 
rate typical for your home region and see what effects it would have for this coastal zone. 

6.3. Exercise b: implementing a policy option 

From the previous exercise it will be clear that demographic pressure influences the 
coastal zone directly (visible as increasing urban BOD loads), but also indirectly (visible 
in the increasing BOD loads from the growing Shrimp culture).  The coastal zone 
manager can only influence demographic growth indirectly and in part.  On top, changes 
in the population growth rate usually take a very long time.  Hence, in most cases, he will 
have to take demographic pressure as a fact and try to mitigate its consequences through 
the design of appropriate accommodating policy measures.  The design of such a policy 
is the purpose of the following exercise. 
 
Aim:  To design policy measures that will mitigate the consequences for the coastal zone 
of a rapidly growing population.  To that end we will first find out whether pollution 
levels could be kept down if water treatment plants were installed.  Because policy 
measures have a price tag, we will check whether the costs are within limits. 
 
Screen arrangement:   
Similar to the previous exercise, we want to be able to change the population growth and 
to see how that affects the BOD loads.  Repeat the steps explained in the previous 
exercise to arrange your screen.  To implement policies, we need to select them from the 
Policy options View.  Click the ‘Waste water treatment’ MBB and drag its dialog 
window to the right side of the screen.  Minimize the Macro-scale window. 
 
What if?:  We will test whether investment in water treatment plants will keep the over-
all water quality as measured by the BOD loads from deteriorating as the region grows.  
Note that the model permits to develop policies related to both urban and industrial waste 
water treatment.  BOD generated by shrimp production can not be dealt with. 
• First enter a population growth rate of 3.19 %. 
• Next, we will check what the initial BOD loads are.  To that end we need to initialise 
the simulation.  During this phase, the initial values of all the variables of the model will 
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be calculated.  Select the ‘Init’ command from the Simulation menu and notice how some 
of the values in the dialogs will change to take their initial value.  Read from the 
Ecosystem Vitality dialog box the figure in the Total BOD load field in the column Value 
at date. 
• We enter this figure in the Total BOD load edit field in the column named Policy 
criterion.  From now on we can read in the column Score at date the difference between 
the value wanted (Policy criterion) and the value measured (Value at date) in the model. 
• First run the simulation with no treatment facility, and at the end of the 10 year run, 
read from the Ecosystem Vitality dialog box the Value at date of the Total BOD load, as 
well as the Score at Date and write it down.  Reset the simulation. 

• Now, we will design a Waste 
water treatment investment 
policy.  To that end activate the 
Waste water treatment dialog 
box.  Decide to install a waste 
water treatment plant for the 
treatment of urban household 
waste waters by clicking the 
check box.  From now on the 
policy will be in effect. 
• Next decide on your treatment 
plant building programme by 
entering the capacity available 
with the graph editor of the 
Total purification capacity edit 
field.  Do not change the figure 
in the Investment per capacity 
edit field.  The latter has been 
set to the correct value for SW 
Sulawesi. 
 

• Enter data in the graph editor that represent a realistic building programme.  Most 
likely the resulting graph should have a logistic form: a slow start, a rapidly increasing 
capacity once the programme has been going for a number of years and finally a slow 
end after the facility has been completed.  The final capacity of your treatment plant 
should be about 0.14 million cubic Meters, since this represents the standard size of such 
a facility. 
• Run the simulation and check the values of Total BOD load as well as the Score at date 
in the Ecosystem vitality dialog box. Examine also the graph of the BOD load.  What has 
been the effect of the treatment facility on the quality of urban waste water ? 
• Now change your capacity curve and Reset and Run the simulation till you get an 
investment level that just keeps BOD loads at a more or less constant level as the 
population grows. 

6.4. Exercise c: studying the impacts of other coastal processes on policy 
effectiveness 

 
After the completion of a dam, the life time of the storage lake  depends on the reservoir 
capacity and on the volume of the yearly inflow of sediments from the catchment area. 
For the Bili-bili dam upstream from Ujung Pandang, the life time of the storage lake is 
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estimated to be 50 years.  In this exercise we will study how large-scale deforestation 
will affect the life time of the reservoir. 
 
Aim:  To study the effects of land-use changes on the life time of the dam and to get 
insight in the micro-scale dynamics and their coupling with the macro-scale. 
 
Screen arrangement:  Arrange your screen such that the micro-scale dynamics window 
is visible.  Select from the view menu the Show Regions command.  This will show the  
boundaries of the administrative regions on top of the land use map.  (You can identify 
the regions on the map, and get an overview of land use data, by clicking-in a region: a 
table of cell counts for the named region will appear.) 

 
Now focus your map such that you 
have a good view of the River 
catchment area above the dam as well 
as the river from the dam down to the 
sea (see the figure).  We want also to 
enter a population scenario and be able 
to work with the Dam construction & 
management policy option.  Hence, 
open the appropriate dialog boxes or 
keep them at hand in their minimized 
form. 
 

Now select from the System diagram the ‘Upstream catchment area’ SuperMBB and 
open the ‘Sediment production’ and ‘Sediment delivery’ MBB’s dialog boxes.  Select 
from the scroll list the Jenerakikang region since that is the one we are interested in for 
the time being. 
 
What if?:  We will run a simulation in which we assume that suddenly (which is rather 
unrealistic) a large part of forested land in the river catchment area above the storage lake 
is deforested and developed for agricultural use occupation.  This simulation run we will 
check against a default run where no changes have been introduced. 
 
• First, enter a population growth of 3.19 % if it is not already set at that value.  Switch 
on the decision to construct the dam (by clicking the check box).  Run the simulation and 
check the changes that take place in the land use of the Jenerakikang region.  To get 
some figures about it, click in the region and see how the land use composition is 
changing.  The changes in the land use, the precise location of the changes in the region 
and the scenario entered for the precipitation in the region will cause the sediment 
production to change.  Write down some sediment production figures while the 
simulation is ticking away the years.  To finish this first part of the exercise, push the 
Reset button from the Tool bar. 
 
New screen arrangement: 
In order to be able to see the details necessary to edit the different maps, you will have to 
resize the Micro-dynamics window such that it occupies the top half of the screen.  Then, 
Zoom-in 2 or 3 times to enlarge the cells to the point that you can easily distinguish 
them.  While doing so, keep the focus of the map on the Jenerakikang region. 
 
• Now, we will develop Jenerakikang into an agricultural area.  Select from the Maps 
menu the Suitability map for agriculture.  Resize, Zoom-in, and position it, so that it is 
below the Micro-scale dynamics window and is also focused on the Jenerakikang region.  

 

Jenerakikang 
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Now fill as accurately as possible all the forested Jenerakikang cells with a suitability 
value equal to 1.  This action is similar to the development of perfect agricultural 
conditions in the region. 
• Close the suitability map and open the Network map. Zoom, resize, and position it, so 
that it is below the Micro-scale dynamics window and is also focused on the 
Jenerakikang region. Build a road through the Jenerakikang region: draw a Link from cell 
(133, 171) to cell (126, 195).  This way the future farmers of the region get road access.  
To confirm this change in the network, select the Compute accessibility command from 
the Edit menu. 
• Close the network map and open the Landuse map to create the agricultural area by 
changing all the forest cells of the Jenerakikang region into agriculture cells. 
• Now, select Save simulation from the File menu and save the simulation with the name 
DEFOREST.SIM.  To that end select form the File menu the Save simulation as… 
command and enter DEFOREST.SIM in the edit field called File name of the Save As 
dialog box.  Next click the Save button.  Next, the Simulation DEFOREST.SIM dialog 
box will open.  Click OK.  Read sections 2.4 and 3.1 of the manual again if saving the 
simulation causes problems. 
• Finally select the ‘Storage lake’ SuperMBB in the Macro-scale dynamics window 
(System diagram View) and open the ‘Storage lake capacity’ MBB’s dialog box.  Now 
run the simulation and check the sediment production and sediment delivery in 
Jenerakikang. 
• Some of the sediment produced will be deposited in the storage lake and reduce the 
lake capacity unless it is being removed.  Notice how the ‘Storage lake capacity’ 
decreases as the years go by. 
 
What-if ?: Now, try out a policy option aimed at removing sediment from the lake.  Find 
out what the costs are to increase the life-time of the storage lake. 
 
• Select the System diagram View.  From the ‘Upstream catchment area’ SuperMBB 
open the ‘Sediment production’ and ‘Sediment delivery’ MBB’s dialog boxes (unless you 
opened them before); from the ‘Storage lake’ SuperMBB open the ‘Storage lake 
capacity’ and ‘Sediment removed’ dialog boxes; and finally from the ‘Employment & 
income’ SuperMBB open the ‘Government spending’ dialog box.  Next switch to the 
Policy options View and under the ‘Dam construction & management’ SuperMBB open 
the Sediment removal dialog box and enter a value of 0.5 (Million cubic Metres). 
• Now run the simulation, noting values for sediment production and delivery, and 
storage lake capacity.  The effective minimum storage capacity of the lake is 
approximately 345 million cubic Metres; below this level the water intake for power 
generation is likely to be blocked by sediment.  How does sediment removal alter the 
effective life-time of the lake ?  At what cost ?  Note that the cost of sediment removal is 
an annual figure and that sediment is removed during one month only. 
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8. ANNEX A: Pointer Shapes 

 
 

Pointer Shape Description 
Standard MS Windows Pointer Shapes 

 
Standard Windows© cursor. 

 
Standard I-beam cursor for editing windows. 

 
Sizing cursor to change the width of the window.  Displayed when the pointer 
is on top of a vertical window border. 

 
Sizing cursor to change the height of the window.  Displayed when the pointer 
is on top of a horizontal window border. 

 
Sizing cursor to change the width and/or the height of the window.  Displayed 
when the pointer is on top of a window corner. 

 
Sizing cursor to change the width and/or the height of the window.  Displayed 
when the pointer is on top of a window corner. 

 
Context Sensitive pointer to get on-line help on the command you click on. 

 
Specific RAMCO Pointer Shapes 

 Insert cursor to insert values in an MBB-dialog edit field by means of the text 
value and table editor. 

 
Insert cursor to insert values in an MBB-dialog edit field by means of the text 
value and graph editor. 

 
Pen cursor to pick a value from the legend of a map and to enter it in a cell; or 
to enter ordinal values in the X-Y graph part of the graph editor. 

 

Bucket cursor to pick a value from the legend of a map and to enter it in a 
group of contiguous cells. 
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9. ANNEX B: Factors and Weights 

This annex contains an overview of the factors and weights as used in an overlay analysis 
to produce a set of suitability maps usable in the SW Sulawesi application. 
 
Factor: Land Use factor 

type Rating per land use function

rice 
culture agriculture schrimp 

culture
rural 
residential

urban 
residential tourism industry mangrove

nature 0 5 5 8 5 5 5 5 7
mangrove 1 5 5 8 5 5 5 5 7
rice culture 2 10 6 7 4 4 3 3 7
agriculture 3 4 8 6 7 7 5 5 4
shrimp culture 4 3 3 8 4 4 2 5 3
industry 5 2 2 2 2 2 1 8 1
tourism 6 3 3 3 4 4 8 2 3
rural resident 7 2 2 1 9 9 5 5 1
urban resident 8 2 2 1 9 9 5 5 1
sea 9 0 0 0 0 0 0 0 0
waters 10 7 5 5 3 3 4 2 5
airport 11 0 0 0 0 0 0 0 0
harbour 12 0 0 0 0 0 0 0 0
beach 13 0 0 0 0 0 0 0 0
island 14 0 0 0 0 0 0 0 0

Factor: Distance 
to waterway

factor 
type Rating per land use function

rice 
culture agriculture schrimp 

culture
rural 
residential

urban 
residential tourism industry mangrove

0-1000 8 6 5 9 9 5 7 8
1000-5000 7 5 5 7 7 5 6 5
> 5000 5 5 5 3 3 5 5 5

Factor: Distance 
to port

factor 
type Rating per land use function

rice 
culture agriculture schrimp 

culture
rural 
residential

urban 
residential tourism industry mangrove

Not used 0 0 0 0 0 0 0 0 0
> 5 km 1 5 5 5 5 5 5 5 5
sea 2 0 0 0 0 0 0 0 0
< 5km 3 5 5 5 3 3 3 9 1

Factor: Elevation factor 
type Rating per land use function

rice 
culture agriculture schrimp 

culture
rural 
residential

urban 
residential tourism industry mangrove

< 0 0 0 0 0 0 0 0 0
0 - 55 8 6 5 6 6 5 6 5
> 55 5 5 5 5 5 5 5 5

Factor: Zoning 
regulations

factor 
type Rating per land use function

rice 
culture agriculture schrimp 

culture
rural 
residential

urban 
residential tourism industry mangrove

Not used 0 0 0 0 0 0 0 0 0
none 1 5 5 5 5 5 5 5 5
sea 2 0 0 0 0 0 0 0 0
industrial 3 1 1 1 3 3 1 9 1
tourism 4 1 1 1 3 3 9 1 2
residential 5 1 1 1 3 3 3 3 1

Factor: Distance 
to coast

factor 
type Rating per land use function

rice 
culture agriculture schrimp 

culture
rural 
residential

urban 
residential tourism industry mangrove

Not used 0 0 0 0 0 0 0 0 0
> 5 km 1 1 1 0 1 1 1 1 0
sea 2 0 0 0 0 0 0 0 0
< 5km 3 1 1 1 1 1 1 1 1

Factor weights Weight per land use function
rice 
culture agriculture schrimp 

culture
rural 
residential

urban 
residential tourism industry mangrove

Land Use 3 2 3 3 3 1 2 1
Distance to waterway 2 2 2 2 2 1 1 2
Distance to port 0 0 1 1 1 0 2 0
elevation 2 1 0 1 1 1 1 0
Zoning Regulation 0 0 0 2 2 2 2 0  
 


